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Chapter 1

Allscripts Patient Flow and the Bed
Management module

The Bed Management module of the Allscripts Patient Flow™ application provides the ability to
efficiently manage the movement of patients through the care delivery process, including different
facility locations.

Bed Management enables better monitoring of the patient placement process and provides you
up-to-date information about Allscripts Patient Flow™ and bed capacity, which reduces bed
placement time. The module provides information about bed availability, patient activities, and
detailed patient information.
Allscripts Patient Flow™ is a browser-based tool that works best with Use Microsoft® Internet
Explorer®.
Areas that you can access in Bed Management vary depend on your assigned roles. Types of
roles include:

> Allscripts Admin
> System Admin
> Transport Dispatcher
> Housekeeper
> Transporter

Note: For best viewing of the Allscripts Patient Flow™ page, set your web
browser to Full Window mode and your window resolution to a minimum
of 1024 x 768.

Log in to Allscripts Patient Flow
To log on to Allscripts Patient Flow™, enter your login credentials on the Allscripts Patient Flow
window.

Before you begin
Verify that you have a valid username and password to access Allscripts Patient Flow™.

If your hospital uses Windows® Authentication as the security method for logging in, you do not
need this procedure to log on to Allscripts Patient Flow™. When you log on to your hospital's
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computer network and open the Allscripts Patient Flow™ application, you are logged on to Allscripts
Patient Flow™ automatically with your default roles and organizations.

1. To access the login page, go to

2. For Username, enter your assigned username and press Tab.
3. For Password, enter your case-sensitive password and press Tab.
4. For Use Default Session, complete one of the following actions:

> To use the default session with your stored user settings, select Use Default Session and
then click Login or press Enter.
You are logged in, checked in, and the Allscripts Patient Flow™ application displays the
splash page.

> To bypass the default session and change your user settings, clear Use Default Session
and then click Login or press ENTER on your keyboard.
The Check In window is displayed, where you can update your information. For example,
if you have multiple roles or have access to multiple organizations, to simplify the display of
information and messages received, choose a specific role and organization. You can also
select a checkout time.
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Log out of Allscripts Patient Flow
For security reasons log out of Allscripts Patient Flow™ whenever you take a break or leave your
computer. Logging out of Allscripts Patient Flow™ is not the same as checking out of it.

To log out, click Logout at the top of the page. The message, You have successfully logged
off displays, and you are logged out of Allscripts Patient Flow™.
To maximize patient safety and minimize security risks, Allscripts Patient Flow™ automatically logs
you out after a specified number of minutes of inactivity. After that time has elapsed, a window
displays, where you must enter your password. If you do not enter a password, a 30-second
countdown begins. If you do not enter a password in 30 seconds, all Allscripts Patient Flow™

windows close and the session ends.

Note: Contact the Allscripts® implementation or Allscripts® support team
to assist with setting up this automatic feature. The countdown interval
and activation of this feature is modified throughApplication Preferences.

Check in to Allscripts Patient Flow
Use the Check In window to change the roles or organizations that you use by default in Allscripts
Patient Flow™, define your access to various pages and functions, or to specify the types of
messages that you want to receive (for example, messages that relate to Allscripts Patient Flow™

and your assigned role).

Before you begin
Verify that you have a valid username and password to access Allscripts Patient Flow™.

This procedure assumes that you are set up with more than one role or organization in Allscripts
Patient Flow™).

1. Access the Allscripts Patient Flow login page.
2. Enter your username and password.
3. Clear Use Default Session and click Login.

The Check In window is displayed.
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4. To select your assigned roles to use in Allscripts Patient Flow™, complete these steps:

a. Expand the Roles list.
b. Select or clear any roles in the list.
c. Click outside the field.

Your selected roles are displayed in the Roles field, and the Organizations list becomes
available.

5. To select your assigned Allscripts Patient Flow™ organizations in which to complete activities,
complete these steps:

a. Expand the Organizations list.
b. Select or clear any organizations in the list.
c. Click outside the field.

Your selected organizations are displayed in the Organizations field.
Also, My Messages becomes available. By default, In Box is selected, which specifies that
any messages sent to you by way of Allscripts Patient Flow™ go to the In Box.
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6. (Optional) To use additional message delivery methods (email or pager), select the following
options under My Messages:

> To specify that messages are delivered by email, select Email and select an email address
from the list.

> To specify that messages are delivered by pager, select Page and select a pager number
from the list.

Your selected email address or pager number displays in the corresponding field.

7. To specify the types of messages to receive, expand Messages and select any available
options.
By default, Standard is selected and cannot be cleared. However, you can select Alert or
Escalation message types.
Along with Standard, your selected message types display in the Messages field.

8. To check into Allscripts Patient Flow™, click Check In.
You are checked in and the Allscripts Patient Flow™ application opens on the splash page.

Check out of Allscripts Patient Flow
For security reasons, check out of your Allscripts Patient Flow™ session at the end of your workday.
When you check out of your session, you are also logged out of the application.

To use Allscripts Patient Flow™ with different settings than your default settings (for example, a
different authorization role), check out of your session.

1. From Allscripts Patient Flow, complete one of the actions:

> Click your name hyperlink at the top of the page.
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> From Account Settings, click Check Out.

2. (Optional) If applicable, use the and to update the check out date or time, and then click
Update.

3. Click Check Out.

Account Settings
Use the Account Settings section to check out of a session or subscribe to messages.

To access options related to your Allscripts Patient Flow™ account, click Account Settings in the
left navigation pane. The available options are based on your assigned system roles and
authorizations.
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Check out or update check out times
Check out of your current Allscripts Patient Flow™ session or update the time to check out.

Use the Check Out window to check out of a session or update the message settings for your
current Allscripts Patient Flow™ session.
Check Out looks similar to the Check In window, which displays when you first log on to Allscripts
Patient Flow™. To change your roles or organizations in Allscripts Patient Flow™, you must first
check out of your current session on Check Out.

1. From the left navigation pane, click Account Settings > Check Out.
Check Out opens.

2. To change the date and time to check out of the session, complete these steps for Checkout
Time.

a. Click and select a new date.

b. Click and select a new time.
c. Click Update.

The updated date or time are displayed in Checkout Time.

3. To check out immediately and close the window, click Check Out.
You are checked out of the session and logged out of Allscripts Patient Flow™. Also, You have
successfully logged off is displayed.

Change message settings
On the Check Out window, update your message settings.

1. Select Account Settings > Check Out on the left navigation pane.
Check Out opens.

2. To add message delivery methods such as Email or Page, complete the following steps in the
My Messages section.

a. Select the box next to any message delivery method.
b. For each selected method, select an option (for example, an email address or pager number).

The selected option displays in Messages. Standard by default, which enables you to
receive standard Allscripts Patient Flow™ messages. You cannot change this value.
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3. To subscribe to additional message types such as Alert or Escalation, click Messages and
select other options.
When selected, Alert or Escalation displays in addition to Standard Messages.

4. Click Update.
Check Out refreshes, and the message settings are updated.

Allscripts Patient Flow sections
Use the sections on the Allscripts Patient Flow™ page to navigate the Bed Management module.

Left navigation pane
Click Bed Management in the left navigation pane to access and manage the Bed Management
module in Allscripts Patient Flow™.

The left navigation pane displays buttons for Allscripts Patient Flow™ modules and functions. The
name of the module and function and its associated icon displays on the button. When you click
a specific button, various options for that module or function.
For example, when you click Bed Management, the various pages associated with that module
display, such as Pre-Admissions Worklist and Bed Management Worklist. The following figure
displays buttons for all Allscripts Patient Flow™ modules, but only the modules that your organization
purchased are displayed to you.
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Messages section
When the left navigation pane is in the expanded view, the Messages window is displayed. The
window displays messages that were sent to you automatically (application generated messages)
or manually by an Allscripts Patient Flow™ user.

The total number of messages is displayed in Inbox (for example, ). Also, the messages
are displayed in a list, as demonstrated in the following image.

Bed Management functions
The Bed Management module has eight main functions that display as options in the left navigation
pane.

These options are:

> Portal View
> Unit View
> Pre-Admissions Worklist
> Bed Management Worklist
> Bed Board
> Floor Plan
> Admissions Worklist
> Closed Bed Worklist

When you click an option in the left navigation pane, the function displays the associated page on
the right side.
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The Floor Plan and Bed Board functions provide information in a graphical format.

Action buttons
Use the action buttons as shortcuts to specific tasks. For example, start a transport request, locate
a patient, or display a floor plan.

FunctionalityAction button

Opens the Transport Request page. This
button displays on allBedManagement pages,
if your hospital also has the Transport module.
The display of this button is also dependent on
your authorizations.

Opens the Patient Locator page, where you
can search for a patient across allWorklist and
View pages by first name, last name, gender,
Medical Record Number (MRN), or case
number. This button displays on all Bed
Management pages.
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FunctionalityAction button

Opens a Search page, where you can search
for patients by last name or MRN on that
specific page only.
If an item matching the search criteria is found,
the page displays only the matching rows. If no
items are found, No Results displays.

If search results are found, is replaced by

. Click this icon to clear the search filter
criteria and display all information.

Refreshes the information on the page.

Displays a Filters window, where you can
define criteria to filter the patient information

displayed on the page. The icon is
available only on a user-created tab. If you are
on the All tab, the icon is unavailable and

displayed as .

Opens Direct Admit, where you can create a
direct admission for a patient.

Exports the data on the page to a different
format, such as a Microsoft® Excel®

spreadsheet.

Displays the Floor Plan for a selected facility,
unit, or pod. This icon is available on the Unit
View page.

Displays the Unit View. This icon is available
from the Floor Plan page.

Opens Patient Details, where you can view or
manage details for the selected patient.
The button displays on most worklists, views,
or the Admissions Worklist page.
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FunctionalityAction button

Displays limited details about the patient (for
example, the patient's care service, care level,
attributes, or needs).

Expands a list. For example, the organization
list is expanded to display the organization
name with a hierarchy of associated facilities,
units, or pods.

Collapses a list. For example, the organization
list is collapsed to display only the organization
name. Associated facilities, units, or pods are
hidden.

Select organizations facilities, units, or pods
Use the organization list to choose the facility, unit, or pod to which you are authorized access,
and to display patient data for those organizations on the associated worklists or pages.

On most main pages, the organization list is on the top left of the page. If you are authorized to
access only one facility, unit, or pod, then the information is displayed automatically in the
organization list. If you are authorized to access multiple organizations, select facilities, units, or
pods (based on your authorizations) in the list by following the steps below, which use the Closed
Bed Worklist as an example.
The options on the organization list vary slightly on the Bed Management pages. Some main pages
enable you to select multiple organizations at the same time. Others, like the Unit View and Floor
Plan pages, only enable you to select one facility and unit.

Note: The following steps demonstrate all the different types of workflows
available on the various Allscripts Patient Flow™ pages or worklists.

1. With Allscripts Patient Flow™ page or worklist open, click the down arrow next to the organization
list.

The organization's facilities that you are authorized to access might be displayed in a hierarchy
list of organization, facility, unit or pod. An asterisk (*) indicates the locations that you are
checked into and selected locations are displayed with a check mark. If an organization check
box is displayed in black, there are some facilities, pods, or units in the organization that are
not selected.
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2. Do one of the following:

> To expand the organization list and display all facilities, pods, or units in the organization
hierarchy, click (expand all option).
Expanding the organization list can take some time if there are many organizations to display.
The arrows next to the facilities and units point down, which indicates an expanded list.

The option is available on Portal View, Unit View, Bed Management Worklist, Bed
Board, Floor Plan, and Closed Bed Worklist.

> To collapse the organization list and display only the organization name, click (collapse
all option).

> To select all organizations with facilities, pods, or units in a single action, click .

> To clear all organizations with selected facilities, pods, or units in a single action, click .
> To select a specific organization, click the check box next to the organization name. All

facilities, pods, and units under that organization are automatically selected.
> To deselect a specific organization and its facilities, pods, or units, click the selected

organization box. All facilities, pods, and units under that organization are automatically
deselected.
The select or deselect options are available onPre-AdmissionsWorklist,BedManagement
Worklist, Bed Board, and Closed Bed Worklist.
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3. To change the organization's facility, unit, or pod selections, complete any of the following steps.

a. To select a different facility, click the arrow to expand the organization hierarchy.
b. Select the box next to any facility.
c. To deselect a facility and any of its selected units or pod, clear the box.

a. To select other units in the same facility, click the arrow to expand the facility hierarchy.
b. Select the box next to multiple units.

A check mark displays next to the newly selected units.

c. To deselect units along with any selected pods, click the box to remove the check mark.

a. To change pod selections in the same unit, click the arrow to expand the unit hierarchy and
do one of the following:

> To select different pods, click the box to add a check mark.
> To clear selected pods, click the box to remove the check mark.

After your updates, a red border displays around the organization list, which indicates that
changes were made.

4. To refresh the worklist and close the organization list, click .
The refresh option is available on Pre-Admissions Worklist, Bed Management Worklist,
Floor Plan, and Closed Bed Worklist.
The organization list closes, and the red border around the box is removed. The associated
worklist or page is updated with your organization selections.

Patient lists
Use the various patient lists in the Bed Management module to view or take action on patient beds.

Each column's heading on the list indicates the type of information in that column. However, the
column headings vary according to the worklist that you select. Except for theAdmissionsWorklist,
all worklist and view pages are displayed with three columns of information.
For example,BedManagementWorklist has a Location,Request Information, andAssignment
column.
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The Location column contains patient tiles, which indicate location of units or pods with beds
along with bed statuses.
The Request Information column displays information such as the patient's name, age, gender,
Medical Record Number (MRN) or diagnosis (Dx).
The Assignment column displays bed placement information such as the assigned provider,
suggested beds with the bed status, or notes. Find a bed, view bed details, or assign a bed from
the suggestions.

Scroll bar for multiple records
If the information records are too numerous to display on a worklist or page, use the vertical scroll
bar that displays on the right of the page. Click and drag the scroll bar up or down to find a specific
record.

Page navigation bar
On Pre-Admissions Worklist, Bed Management Worklist, and Closed Bed Worklist, the rows
of information are usually too numerous to display on one page, and the list of rows display across
multiple pages. Use the page bar at the bottom of the page to view the page numbers and rows,
or click the arrows to navigate to pages.

Click to go to the next page, or click to go to the last page.

Click to go to the previous page, or click to go to the first page.
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If there are no previous or next pages, the arrows are not available. For example, the following
figure demonstrates that there are no previous pages because you are on the first page.

Unit View-activity pane
Use the activity pane on Unit View to view activity requests for a selected unit or pod (for example,
required actions, pending arrivals, intra-unit activities, or waiting Admission, Discharge, Transfer
(ADT) activities).

View or take action on pending activity details for each patient in the Pending Activity column on
Unit View.
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Chapter 2

Bed Management module

The Bed Management module is a browser-based tool, which enables you to efficiently manage
movement of patients through a facility. This module provides better monitoring of patient placement,
displays up-to-date information about Allscripts Patient Flow™ and bed capacity, and reduces bed
placement time. View information such as bed availability, patient admissions, transfers, and
detailed patient information.

Note: Use Microsoft® Internet Explorer® as your preferred browser for the
Allscripts Patient Flow™ application.

Access the Bed Management module
To access the Bed Management module, click Bed Management on the left navigation pane of
Allscripts Patient Flow™.

Depending on your assigned roles, use any of the views or worklists listed underBedManagement.
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Bed Management views and worklists
The Bed Management module has two views and four worklist panels. You might have access to
one, several, or all panels, but you can only view the panels for which you have permission to
access. Click a view or worklist option to display the associated panel.

Table 1: View or worklist descriptions

DescriptionView or worklist

Use this view to create requests or to view the
status of each request. Requests include:

> Direct Admit
> Admission
> Discharge

Portal View

Use this view to create requests or to view the
status of each request and bed. Requests
include:

> Discharge
> Bed Swap
> Change Room or Bed
> Bed Cleaning

If necessary, use the Unit view to respond to
bed placement requests. A Floor Plan view of
beds and rooms is available.

Unit View

Use this worklist to:

> View Pre-Admissions Requests.
> Edit and resubmit the requests.
> View the request status.

Pre-Admissions Worklist
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DescriptionView or worklist

Use this worklist to:

> Create Direct Admit requests.
> Find a bed.
> Reserve a bed.
> Cancel or reject a reservation.
> Place a bed hold.
> Cancel a bed hold.
> Place a notification on a bed.

Bed Management Worklist

Use this view to view beds, filter beds by
attributes, or display bed details.

Bed Board

Use this view to view rooms and beds for the
selected facility, unit, or pod.
To directly access the Floor Plan function, click

on the Unit View panel.

Floor Plan

Use this worklist to process requests and view
data to consolidate admission records.

Admissions Worklist

Use this worklist to view a list of closed beds
and the closure details. Update or cancel the
bed closure, or edit the bed status.

Closed Bed Worklist

Use the worklist or view panel to create, cancel, edit, or view specific requests. The following table
lists the request capability of the panels. Your access and ability to complete these requests
depends on your role, user permissions, and the modules that your practice has purchased.

Request capabilityWorklist or view

> Admissions
> Direct Admissions (configurable for this panel;

might be turned off in your hospital)
> Discharge
> Transfer

Portal View
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Request capabilityWorklist or view

> Bed Swap
> Bed Status (Housekeeping, Close Bed)
> Discharge
> Change Room or Bed (Move)
> Patient Placement Response (Accept, Edit,

Reject, Cancel)
> Transfer

Unit View

Request ProcessingPre-Admissions Worklist

> Direct Admissions
> Request Follow-up
> Patient Placement
> Transfer

Bed Management Worklist

> Bed Turnover
> Bed Closure
> Transport
> Transfer
> Discharge
> Change Room or Bed (Move)

Bed Board

> Bed Turnover
> Bed Closure
> Transport
> Transfer
> Discharge
> Change Room or Bed (Move)

Floor Plan

Request ProcessingAdmissions Worklist

Close Bed (Edit, Cancel)Closed Bed Worklist
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Icons
An icon is an image on the Allscripts Patient Flow™ panel that represents a function or activity. If
you point to an icon, a panel tip displays with a brief description of the icon. For example, point to
the calendar icon ( ) to display Open the calendar window.

Common icons
Other than the error icon ( ), click a common Allscripts Patient Flow™ icon to use the associated
feature.

Table 2: General icons

PurposeLocationIcon

Collapses the left navigation pane to display
more information on the right of the pane.

Top of left navigation
pane

Collapses the activity pane on the right and
display more information on the left of the pane.

Unit View

Click the down arrows to expand the section
and display any pending activities. Click the up
arrows to collapse the section.

Activity pane on Unit
View

Displays on a patient row if a request is made
for the patient (for example, a Bed Transfer,
or Discharge Request).
Click to display a Cancel panel, where you
can select a cancellation reason.

On the right of patient
rows on most work list
panels

Closes the current panel without saving new
information.

Top right of window and
other panels

Opens a calendar, where you can select a date.Check In and other
panels

Opens a time picker, where you can pick
one-hour time intervals.

Check In and other
panels

Displays when data is missing from a required
box after you try to save information on a panel
or attempt to proceed to the next step.

Data entry panels
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PurposeLocationIcon

Displays when an error is made in a date box
(for example, you enter a future date in Off
Floor Date Time on Move Patient Off Floor).

Several pop-up panels
(for example, Move
Patient Off Floor)

When is displayed, enables you to view
previous notes.
If a note does not currently exist for the patient,

displays. Click the icon to add a note.
Refer to the information in Use the Notes
Function.

Patient row on most
worklists and view panelsor

Displays on the right of the patient's name.
Click this icon or the patient's name to open
Patient Details.

Patient row on most
worklists and view panels

If a very important person (for example, a
celebrity) is selected as a Confidentiality
attribute for a patient, displays on the right
of the patient's name.
This functionality is available when the Very
Important Person box is selected for the
Confidentiality attribute on Attributes
Maintenance in Admin.

Patient row on Portal
View, Unit View, and
Bed Management
worklist panels or the
activity pane on the Unit
View panel

Identifies the material jobs displayed on
Transport Worklist.

Left side of the Material
Jobs tile on Transport
Worklist
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Patient tiles
Use the patient tiles to view pertinent information (for example, bed statuses, bed locations, isolation
indicators, or patient activity information). All worklist panels, except for Admissions Worklist,
are displayed with patient tile icons.

The top panel of the patient tile displays a bed status color. For example, if a bed is in the cleaning
process, a yellow color is displayed. If a bed is occupied, a light blue color indicates a male patient,
or a light pink color indicates a female patient.
A bed location identification, known as the "Bed ID", also displays in the top panel. The short
version of the Bed ID indicates the room and bed location. For example the information is displayed
on the Portal Viewand Unit View panels, or the facility, unit, or pod location for the bed is displayed
in Facl/Unit/Pod. The longer version of the Bed ID includes the facility, unit, or pod identifier, which
displays on Bed Management Worklist and other panels. The length of time that the patient has
occupied the bed is on the right (for example, 1MO for one month).
If there is any request activity for the patient, the bottom panel of the patient tile displays an icon,
which indicates the type of request. For example, if a transfer is requested, the Transfer icon (Tx)
displays in the bottom panel. A timer displays the time progression from when the activity was
initiated (for example, 5M for five minutes or 1D for one day).
Examples of patient tiles that might display are described in the following table.

DescriptionTile example

Indicates an available bed.

The start indicates that there is a bed ahead of
the available bed.

Indicates that the bed is dirty and reserved for
another patient.
In this example, the dirty status is three days
(3D) and a patient is reserved for this bed (R).
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DescriptionTile example

Indicates that the bed is dirty and the next bed.
In this example, the patient is on floor (On) and
the bed is in a dirty status for eight minutes (8M).
The red corner indicates an openBed Turnover
or Bed Repair request, which might result in an
ADT mismatch if the patient is still occupying
the bed in Allscripts Patient Flow™.

The solid blue color indicates that a male patient
is in the bed and on floor (On).
In this example, the patient's length of stay is
two days (2D) and the patient is scheduled for
a transfer in four hours (Tx 4H).

The pink color indicates that a female patient is
in the bed and on floor (On).
In this example, the pink stripes indicate that an
ADT activity is pending for the patient.

The orange striped border indicates an isolation
bed that is occupied by an isolation patient
In this example, a male patient is in bed and:

> The patient's length of stay is 28 days (28D).
> The patient is scheduled for discharged at

1:55 pm (DC 13:55).
> The patient is currently off floor in the Kidney

location.
> The patient is expected to return fromKidney

in two hours (2H).
> Another patient is reserved to this bed or

"hot-bunked" (R)).

Note: If a patient is in a semi-private bed
on isolation and has a non-isolation
roommate, the non-isolation roommate's bed
tile border displays asNormal.
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DescriptionTile example

The blue striped border indicates an at-risk
patient.
In this example, the female patient's length of
stay is one month (1 MO), the patient is in bed,
and on floor (On).

Note: For a portal that is set up as a Portal
Unit, the at-risk borders do not display on the
Portal View. At-risk borders display when the
portal unit beds or patients are viewed from
Unit View.

The purple border indicates a ring-fenced bed.
In this example, a female patient is in bed, the
patient's length of stay is 11 months (11MO),
and the patient is scheduled for a transfer in two
months (Tx 2MO).

The pink and blue striped border indicates that
an isolation patient and an at-risk patient are
sharing the same room.

Use the following bed status colors on the patient tiles to determine the current bed status.

StatusColor

Available(green)

Dirty(brown)

Dirty, next(lighter brown)

Dirty, urgent priority(reddish brown)

Cleaning in progress(yellow)

Cannot clean (Delayed cleaning request)(purple)

Closed(black)

Occupied by female patient(pink)

Occupied by male patient(blue)
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StatusColor

Occupied by unknown gender(grey)

Patient activity timers and bed statuses
Use the patient activity timers and bed status indicators that display on Allscripts Patient Flow™

patient tiles.

The following table provides information about the bed-cleaning status timers that are displayed
in the bottom panel of the patient tile. If the bed-cleaning job is escalated, the status timer is
displayed in a red color.

Table 3: Bed-cleaning status timers

DescriptionStatus abbreviation

Minutes (up to 90)M

Hours (up to 23)H

Days (up to 30)D

Months (up to 11)MO

YearsY

The table following provides explanations of patient activity status indicators. Light grey indicators
apply to bed requests that are processed within the patient's facility.

Table 4: Patient activity status indicators

DescriptionIndicators

A pending patient admission.

The patient is ready to move.

A direct patient admission.

The patient has a bed reserved.

The patient is held to a bed.

A pending transfer is scheduled for the patient.
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DescriptionIndicators

A pending transport is scheduled for the patient.

A pending discharge is scheduled for the patient.

A pending discharge with physician orders and
other criteria is scheduled for the patient.

The patient is located on the floor.

The patient is located off floor (for example,RAD
indicates that the patient is in Radiology).

Off floor indicators

Common workflows
Use common workflows in Allscripts Patient Flow™ such as searching and filtering views or worklists,
locating patients, or viewing patient histories.

Required information
When you create a new item or edit an existing item, most required boxes are indicated by an
asterisk (*) on Allscripts Patient Flow™ panels. If information is missing from a required box on a
panel and you try to submit the information, an error message or the error icon ( ) is displayed.

For example, on Bed Swap, you must select an option in the required Select Patient list to change
the beds of a patient.
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Security timeout
For security and privacy reasons, Allscripts Patient Flow™ has a timeout functionality, which
automatically logs you out of the application after a specified time of application inactivity.

If you log on to Allscripts Patient Flow™, but do not use it for a specified length of time, the panel
automatically closes and the Allscripts Patient Flow™ Please Login panel displays. You must log
on again to access the Bed Management module. Save your changes periodically because if the
timeout feature logs you out, any unsaved changes are gone and cannot be recovered.

Note: Specified timeouts are configured by your organization's system
administrator.

Expand and collapse rows
To control the amount of information that is displayed, expand or collapse rows.

The rows on some worklist panels, such as the Bed Management Worklist panel, display a short
summary of patient information. This collapsed view displays more patient rows on the panel. To
expand the information, click a row. To collapse the expanded view, click the row again.
For example, when you click a row on Bed Management Worklist, the row is highlighted and
expands to display more bed request information, such as Attributes, Needs, and Bed Request
Priority. If an open bed request is indicated for the patient, more available beds (if matched) are
displayed when the row is expanded.

If patient information is displayed in the Activity Pane on Unit View, click inside the patient's row
to expand the row or click inside the row again to collapse it. Admissions Worklist displays the
expanded view of patient information in a different way.
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Use search functionality
Some Allscripts Patient Flow™ panel fields include a search icon (for example, ). Click to
display a window that enables you to quickly search for a specific item (for example, a physician
name).

In this workflow example, use onDirect Admit to find an admitting physician. The same workflow
applies to other fields or panels where the search icon displays.

1. Click ) on the Portal View orBedManagementWorklist to open theDirect Admitwindow.
TheAdmitting Physician,Attending Physician, andReferring Physician fields are displayed
with .

2. For Admitting Physician, click .
The Admitting Physician panel displays.

3. Enter information into at least one field.
For example, enter the first few letters of the physician's last or first name. To further refine the
search, select a value from Care Service or enter the physician's MCR number.

4. Click .
As an alternative workflow, use the scroll bar to locate and select the physician’s name.
A list of admitting physicians that match the search criteria displays.

5. Do one of the following:

> If the name of the admitting physician displays, double-click the physician's name.

> If the name of the attending physician does not display, change the search criteria and click

again. Double-click the physician's name.
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The Admitting Physician panel closes, and the selected physician's name displays in the
Admitting Physician field on Direct Admin.
If necessary, repeat the steps for Attending Physician or Referring Physician.

Use tabs and filters
Use the tabs in Allscripts Patient Flow™ to display patient information, locations, requests, and so
on. If necessary, create a new panel that is customized with your search and filter preferences.

The All tab is the first tab that displays on a worklist or view panel by default, and its name displays
on the top left of the panel. All patients, locations, requests, and so on pertaining to that worklist
or view panel display on the All tab. Initially, the All tab is the only tab that displays.
All worklist or view panels enable you to create a custom tab. After you name the new tab, a Filters
panel displays that enables you to select filter criteria. Patients, locations, requests, and so on that
do not meet the specified criteria are filtered out and do not display on the worklist or view panel.
The Sort By box does not limit the number of rows displayed, but sorts the rows by a certain
criteria ( for example, by patient name). This filter functionality helps you find specific patients,
locations, requests, or other items more quickly.
The boxes that display on the Filters panel depend on the current worklist or view panel. For
example, the Filters panel for the Pre–Admissions Worklist has a Pre–Admit Date Time box
that does not display on the Filters panel for the Unit View.
You can select multiple options for some boxes. If you do not want to use a box, leave it blank.
For example, if you want to search for Patient Transfer requests on the on the Unit View Filters

panel, click for Request Type and then select the Patient Transfer box.

To define the search for male patient requests, click for Pt Gender and then select Male. Leave
other boxes blank.
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When you click Filter Now on the Filters panel, the panel closes and only locations with a Patient
Transfer requests and male patient occupants are displayed on theUnit View panel. If no patients
match the filter criteria, No records to display, is displayed on the panel.
The activity pane information is not affected by the filtering, and any new patients in the Action
Required or Pending Arrival sections are not filtered out.
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To use the filter functionality, create and name a filters tab, which is then used to save the filters
options that you specify. The name of the new filters tab displays on the right of the All tab on the
worklist or view panel. This filters tab is saved and displayed on your view of that specific worklist
or view panel whenever you access it.
For the Unit View panel, the tab displays for all units that you can access. The tab is not displayed
to other users. If you no longer want to use the custom tab, delete it. To view all locations in the
unit again, click the All tab.

All tabs
Use the All tab on a Allscripts Patient Flow™ view or worklist to view information about patients,
locations, requests, and so on.

To display the information, click the All tab at the top of the view or worklist. No rows are filtered
out on the All tab, and you cannot delete this tab.

Create custom filter tabs for worklists
Create a custom tab and select filters to display on the Pre-Admissions Worklist, Bed
Management Worklist, or Admissions Worklist.

1. In the Bed Management module, open the worklist to edit.
The worklist panel displays and the All tab is the only tab that initially displays on the left side
of the panel.

2. From the organization list, select or clear organizations to include or exclude in the tab.

3. Click .
4. On the Add Tab window, enter a short name for the tab in Tab Name.

You cannot enter symbols into this field.

5. Click OK.
The Add Tab panel closes, the custom tab name is saved, and the new tab displays next to
the All tab. Also, the filter window for the worklist opens.

6. To specify how the worklist is sorted, click next to Sort By on the filter window and select
values from the list.

7. To select specific filter values, click next to any field and select values from the list. If
necessary click the calendar or time picker icons to select dates or specify times.
Values on the filter window can vary, depending on the worklist that you chose. The following
figure is an example of the Pre-Admissions Worklist Filters window.
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8. After selecting all filter values, click Filter Now.

Results of this task
The custom tab is created and displayed at the top of the worklist. When you click the tab on
subsequent sessions, the worklist is sorted and filtered according to your filter selections.
If necessary, edit or update the custom tab and filters.

Create custom filter tabs for views
Create a custom tab and select filters to display on the Unit View or Portal View.

1. In the Bed Management module, open the view to edit.
The view panel displays and the All tab is the only tab that initially displays on the left side of
the panel.

2. From the organization list, select or clear organizations to include or exclude in the tab.
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3. Click .
4. On the Add Tab window, enter a short name for the tab in Tab Name.

You cannot enter symbols into this field.

5. Click OK.
The Add Tab panel closes, the custom tab name is saved, and the new tab displays next to
the All tab. Also, the filter window for the view opens.

6. To specify how the view is sorted, click next to Sort By on the filter window and select values
from the list.

7. To select specific filter values, click next to any field and select values from the list. If
necessary click the calendar or time picker icons to select dates or specify times.
Values on the filter window can vary, depending on the view that you chose. The following figure
is an example of the Unit View Filters window.
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8. After selecting all filter values, click Filter Now.

Results of this task
The custom tab is created and displayed at the top of the view. When you click the tab on
subsequent sessions, the view is sorted and filtered according to your filter selections.
If necessary, edit or update the custom tab and filters.

Edit criteria on custom tabs
Edit the filter or sort criteria on a custom tab for a worklist or view.

1. In the Bed Management module, open the worklist or view to edit.
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2. Click the custom tab.
You cannot edit the All tab.

3. Click .
4. On the filters window, update any fields.

To remove information from specific fields, click and clear any selected values.

5. Click Filter Now.
The filters window closes and the new filter criteria displays on the custom tab for the worklist
or view.

Delete custom tabs
Delete a custom tab that contains search and sort filter criteria for worklists or views.

1. In the Bed Management module, open the worklist or view to edit.
2. Click the custom tab.

You cannot delete the All tab.

3. Click .

Important: Verify that you want to delete the tab before you click
because no confirmation panel displays.

The custom tab is removed from the worklist or view.

Messages functionality
Use the Messages functionality to view, create and send, or delete messages within Allscripts
Patient Flow™. Expand the left navigation pane to display the Messages options.

Messages does not have the same functionality as an email application, such as Microsoft®

Outlook® because it is limited to people and organizations that are defined in Allscripts Patient
Flow™.
Your organization's system administrator can configure Messages to receive applicable types of
messages (for example, Standard, Escalation, and Alert), and to subscribe to various messages
by default. If you have the applicable permissions, click Account Settings and change these
message settings on the Check Out or Message Event Subscriptions panels.
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View messages
Use the Messages functionality to view messages that are exchanged within Allscripts Patient
Flow™.

1. Click to expand the left navigation pane and display the Messages options.

The Inbox button (for example, ) indicates the total number of messages received.
Messages are displayed in chronological order with the most recent message first. Only the
first 30 characters of a message are displayed.

2. To view the list of messages in an expanded view, click Inbox.

You can also create or delete messages from this expanded view.

3. To filter the list of messages,select one of the followings values from Sort By.

> Date
> Subject
> Status
> Message

4. To sort the list of messages, select one of the following:

> Descending (default)
> Ascending

If necessary, use the scroll bar to navigate long lists of messages.
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Create and send messages
Create and send messages using the Messages functionality in Allscripts Patient Flow™.

1. Click to expand the left navigation pane and display the Messages options.
2. From Messages, complete one of the following steps:

> Click .

> Click Inbox and then click .

3. Select a recipient name from the list.
4. (Optional) To search for a specific recipient, enter a name into the Name field and press Enter.
5. Click Add.
6. In Message, enter any text.
7. Click Send.
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Delete messages
Delete messages in your inbox with the Messages functionality in Allscripts Patient Flow™.

1. Click to expand the left navigation pane and display the Messages options.
2. From Messages, complete one of the following steps:

> To delete an individual message, click next to the message.

> To delete all messages in a single action, click .

> Click Inbox. On Messages Inbox, click or .

The messages are removed from the Messages pane and from Messages Inbox.
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Patient Locator
The Patient Locator functionality is available for all Bed Management modules to help you find

patients currently located in your facilities. Click at the top right of the panel to
display the Patient Locator panel.

Locate patients
Locate a patient in the Bed Management module of Allscripts Patient Flow™.

1. With the Bed Management module open, click .
2. On Patient Locator, enter criteria in any of the fields in SEARCH. Search criteria includes:

> Last Name: Enter the first few letters of the patient's last name.
> First Name: Enter the first few letters of the patient's first name.
> Gender: Select a gender value from the list.
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> MRN: Enter the patient's Medical Record Number (MRN).
> Acct#: Enter the patient's account number.

3. Click Search or press Enter.
A list of patients who match your search criteria are displayed. If necessary, click Clear to clear
the search criteria and start over.

4. To view patient information, complete one of the following actions.

> Click the patient's name. A summary of the patient's information and location are displayed
on Patient Locator.

> To details for the patient, click Patient Details. The Patient Details panel opens. Depending
on your permissions, view or update items such as the patient's attributes, requests, notes,
and so on.

5. On Patient Locator, click Close.

Patient Details
Use the Patient Details panel to view and edit details for a patient (for example, patient attributes,
requests, notes, and so on.) The current visit information for the patient is also displayed on this
panel.
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Depending on your assigned permissions, access Patient Details in the following ways.

> On Portal View, Pre-Admissions Worklist, or Bed Management Worklist, click a patient's
name.

> On Admissions Worklist, select a patient and then click Patient Details.
> OnUnit View, click the patient's name to open Patient Summary and then click Patient Details.

> In the banner, click , search for and select the patient, and then click Patient
Details.

You can view information on this panel, but the role and user permissions associated with the
authorization item, Patient Details - Update, determine whether you can edit the information.
Also, fields on some of the tabs are configurable (for example, the fields on the Attribute tab).

DescriptionPatient Details tabs

Displays the patient's visit information and
configured patient attributes such as patient
safety and isolation. The selected attributes
specify the bed search for the patient as well as
the icons that are displayed for the patient on
Floor Plan.

Attribute

Displays information about pending requests
(for example, Transfer requests).

Requests

Click New to enable the Details pane, where
you can select a patient note type and enter text.
Patient note types might include:

> Patient Address
> Bed Request
> Care Visibility Note
> Diagnostic
> General
> Nursing
> Patient
> Procedural
> Schedule Remarks
> Other Schedule Details

Any patient notes are displayed under theNotes
tab with the date the note was entered, the date
that the note becomes inactive, and the note
text.

Notes
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DescriptionPatient Details tabs

Click New to enable the Details pane, where
you can enter the contact name for the patient,
relationship, contact method, and address and
phone numbers.
The contact information that you enter is
displayed under the Contacts tab.

Contacts

Displays the name, specialty, and contact
information of the patient's medical providers
(for example, the admitting or attending
physician).

Medical Provider

Displays the patient's current tasks. Select the
Discharge Milestones or Transfer Center
Tasks value to filter the tasks.

Task List

Displays the fields and patient attributes that are
identified in the administration tool for Patient
Fields and Attributes.

CV Indicators

Notes functionality
In the Bed Management module, create notes on all worklist or view panels, except for the Closed
Bed Worklist, or create patient notes during a request workflow.

Patient notes
Use theNotes tab to create patient note types and also indicate if ta patient's notes are deactivated
at a future time.
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Patient notes are saved and associated with a patient's visit. A patient can have multiple notes
associated with a visit. If the patient has had multiple visits, the notes are stored separately
according to the visit number. For example, a patient might have moved between visits, so the
address can be stored as a Patient Address note type according to the visit.
The Patient History panel displays the information for the patient's visits. On the Visit Information
tab, select a visit number. Click the Notes tab to view the notes that are associated with that
specific visit.

Create patient notes
Use the Notes tab to create patient notes or specify when notes become inactive.

Before you begin
Verify you have the adequate permissions to save information on Patient Details.

1. In the Bed Management module, access the Patient Details panel from a view or worklist.
2. Click the Notes tab.

Any existing notes for the patient are displayed in chronological order.

3. Click New.
The Details section opens.

4. Select a value from Note Type.
Patient note type values might include:

> Patient Address
> Bed Request
> Care Visibility Note
> Diagnostic
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> General
> Nursing
> Patient
> Procedural
> Schedule Remarks
> Other Schedule Details

5. (Optional) To specify a date and time for the patient note to be deactivated, enter information
into Inactive Date.

Tip: Click to select a date or click to select a time.

6. For Notes, enter any text.
7. Click OK.

The note is displayed under the Notes tab with the note type. If you added a deactivation date
and time, that information is also displayed under Inactive Date.

Important: Verify that the new note is correct on the Notes panel
before you save. Patient notes cannot be edited or deleted.

8. To save the action, click .

Request workflow notes
In addition to patient notes, create notes during a request workflow (for example, from Bed
Management Worklist, Direct Admit, or Discharge and Milestones).

For example, on Bed Management Worklist, the or options might be displayed
under Assignment.

The option indicates that notes are added to the patient record. Point to the icon to display
a tooltip with the most current note. To view all notes or add a new note, click the icon or Notes.
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The option indicates that no notes are added. Point to the icon to display Add a note.
To add a new note, click the icon or Notes.
The Notes window opens with a list of notes created for the request. If no notes exist, No Notes
is displayed.

To prevent the note from displaying to all users and make it private, clear Note visible to all users.
A private note is visible only to the person who created it and to any user with the same role as
the note creator at the time the note was created.
For example, if a user is assigned to the Bed Control and Nursing Supervisor roles but checks in
only as a Nursing Supervisor and then creates a note, any user who is signed in with the Nursing
Supervisor role can view the note. If the note creator checks in later with only the Bed Control role,
they cannot view the note because it was created with the Nursing Supervisor role.
You can also add a note when you create a Direct Admit Bed request. For example, on Direct
Admit, enter notes pertaining to this request in the Notes field. If necessary, clear Note visible
to all users to make the note private.
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After submitting the request, view the associated note. When you point to , the notes are
displayed like a tooltip. For a Direct Admit Bed request, the notes that you entered are also
displayed in the Bed Management Worklist. Also, if Direct Admit functionality is used on Portal
View, the note is displayed in the Bed Management Worklist.
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After a workflow for a patient request is completed, the workflow notes are stored in the Workflow
tab in Patient History. To access these notes, click Workflow, double-click a workflow, and view
the Notes section in Workflow History.

Finally, you can also enter notes for other types of request workflows. For example, when a
discharge request is created for the patient, enter notes pertaining to the request in the Notes field
on Discharge and Milestones. If necessary, clear Note visible to all users to make the note
private.
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Create request notes
Create notes about the patient during a request workflow.

1. To create a note in a worklist or view that displays the note options ( or ), complete
the following steps:

a. Click or .
b. On the Notes window, enter text into Add a Note.
c. (Optional) To specify that the note is private, clear Not visible to all users.

A private note is visible only to the person who created it and to any user with the same role
as the note creator at the time the note was created. By default, Not visible to all users is
selected and the note can be viewed by all users.

d. Click Add.
The request note is added toNoteswith your name and the date and time of the note creation.
If you designated the note as private, it is displayed in blue.

e. Click Close.

After you save or submit the request, the note is added to the patient's record and applicable
pages.

2. To create a note on a window (for example, Direct Admit or Discharge and Milestones),
complete the following steps:

a. Enter text into the Notes field.
b. (Optional) To specify that the note is private, clear Not visible to all users.

A private note is visible only to the person who created it and to any user with the same role
as the note creator at the time the note was created. By default, Not visible to all users is
selected and the note can be viewed by all users.
After you save or submit the request, the note is added to the patient's record and applicable
pages.
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Patient History
Use the Patient History panel to view a patient's history (for example, visit information, care team,
contacts, notes, and so on).

To access Patient History, open Patient Details and click the patient history icon (for example,

).

Patient History is view-only so you cannot enter any changes to patient data on this panel. To

select a previous patient visit, click for Visit on the Visit Information tab. The information that
displays on the panel corresponds to the visit number that you select.

DescriptionPatient History tab

Displays information for the visit number
selected in Visit. This tab displays when the
panel initially opens and information for the
current visit displays by default.

Visit Information

Displays medical providers associated with the
patient's visit.

Care Team

Displays any contact information that was
entered in the Patient Details panel.

Contacts
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DescriptionPatient History tab

Displays any notes that were entered in the
Notes tab on the Patient Details panel (for
example, the patient's address).

Notes

Displays the history of the care level that is
assigned to the patient (for example General or
Intensive Care).

Care Level

Displays the history of the type of medical care
that is requested for the patient (for example,
Internal Medicine).

Care Service

Displays a history of the patient's diagnoses for
selected visit.

Diagnosis

Displays any workflow information for the
selected visit (for example, Pending
Discharge).
Click this button to display theWorkflowHistory
panel in view-only format.

WorkFlow

Displays a list of accommodation codes
assigned to the patient.

Accommodations

Displays the patient class for the selected visit.Patient Class

Displays all of the bed class changes and the
person who last modified the bed class.

Bed Class

Displays the patient condition for the selected
visit.

Patient Condition

Displays any attribute information that was
entered in the Patient Details panel.

Attributes

Displays a history of all patient locations from
the origin of admission through discharge.

Location Status

Displays various patient information
(configurable) for the selected visit, such as the
patient's home phone.

Patient Fields

Displays the task list for the patient's selected
visit.

Task List

Displays a history of Real Time Location
System (RTLS) tags assigned to the patient.

RTLS
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DescriptionPatient History tab

Displays a history of milestones completed (for
example, Discharge).

Milestones

DescriptionPatient History tabs

Displays information for the visit number
selected in the Visit box. This tab displays when
the panel initially opens, and information for the
current visit displays by default.

Visit Information

Displays medical providers associated with the
patient's visit.

Care Team

Displays any contact information that was
entered in the Patient Details panel.

Contacts

Displays any notes that were entered in the
Notes tab on the Patient Details panel, such
as the Patient Address.

Notes

Displays the history of the Care Level assigned
to the patient, for example General, Intensive
Care.

Care Level

Displays the history of the type of medical care
that is requested for the patient, for example,
Internal Medicine.

Care Service

Displays a history of diagnoses the patient has
had during the selected visit.

Diagnosis

Displays any workflow information for the
selected visit, such as a Pending Discharge.
Clicking this button displays the view-only
Workflow History panel.

WorkFlow

Displays a list of accommodation codes that the
patient has had.

Accommodations

Displays the patient class for the selected visit.Patient Class

Displays the patient condition for the selected
visit.

Patient Condition

Displays any attribute information that was
entered in the Patient Details panel.

Attributes
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DescriptionPatient History tabs

Displays a history of all patient locations from
the origin of Admission through Discharge.

Location Status

Displays various patient information
(configurable) for the selected visit, such as
Home Phone.

Patient Fields

Displays the task list for the patient's selected
visit.

Task List

Displays a history of Real Time Location System
tags assigned to the patient.

RTLS

Displays a history of milestones completed, for
example, for Discharge.

Milestones

View pending discharge milestone task ratios
From the Portal View orUnit View, view the task ratio for a patient's pending discharge milestones.

If a patient has a pending discharge, it is indicated by a DC icon ( , , or ) in the Pending
Activity column or patient tile.
If a patient has pending discharge activity with milestones, the discharge milestone tasks ratio is
displayed on the right of the DC icon. A ratio of completed to total milestone tasks is displayed as
a link. For example, 3:26 indicates that three out of 26 tasks are completed, or 0:0 indicates that
no tasks are completed.

Click the ratio link to display Discharge and Milestones, where you can view or update the
assigned tasks.
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In the application, if a task is assigned a status where the Complete YN = Y, the complete to total
ratio is updated. Complete statuses include: Complete, Entered in Error, or Not Required.
The following table provides explanations of the Discharge and Milestones status values.

Complete YNStatus descriptionStatus

NAssignedASSN

YCompleteCMPL

YEntered in ErrorERR

NIn ProgressINPR

YNot RequiredNTRQ

NOpenOPEN
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Chapter 3

Portal View

Portal View is a specific area that acts as a gateway for hospital patients. For example, the
Emergency Department is considered a portal.

For each portal that you work in, use the Portal View to view information such as bed location
and status, patient information, and physician information. Information for new admitted patients
transmitted through HL7 messages displays on Portal View. Also, use Portal View to create, edit,
or cancel bed, direct admit, discharge, and transfer requests, and view the status of each request.
To access the Portal View page, click Bed Management > Portal View in the left navigation
pane.
Use the Facl/Unit/Pod list on Portal View to display the patients who are assigned to a specific
facility, unit, or pod. If you work in only one unit or pod, the name of that organization displays
automatically in the Facl/Unit/Pod box. If you work in multiple organizations, you can choose a

different organization from the list. Click and select the specific organization from Facl/Unit/Pod.
Your view of organizations is also based on your role and user permissions. You can view
organizations only where you work and have access to the organization's patients. For example,
if you work in Surgery and Same Day Surgery, you can only view information for those organizations.
You cannot view bed information for other organizations, such as the Emergency Department.
Use the following icons under the Pending Activity column on Portal View to view patient
information or create requests:

> (transport icon)

> (transfer icon)
> (discharge icon)
> (admission icon)

However, if the request type is not applicable or if a patient has an incomplete request, the icon
for that request is unavailable and displayed in grey. For example, in the following image, the
patient already has a bed so the admission icon displays in grey. Transport requests are different
because a patient can have multiple transports requests at the same time.
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Chapter 4

Portal View workflows

From Portal View, complete workflows such as direct admit, transport, or transfer of patients.

Direct Admit functionality
When enabled for your organization, use the Direct Admit functionality on Portal View to directly
admit a patient. The functionality is also available on the Bed Management Worklist.

Click to open the Direct Admin window.
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Create Direct Admit requests
Use Direct Admin to create and submit a bed request for a direct-admit patient.

1. In the Bed Management module, access Portal View.

2. If your organization is not displayed on Portal View, click next to Facl/Unit/Pod and select
the applicable organization.

3. Click .
Direct Admit opens on the Patient Details Screen I section.

4. Enter information to all required fields, which are designated with an asterisk (*).
Enter information into optional fields or leave the fields blank. The individual fields are described
in the following table.
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ActionField

Enter the last name of the patient.Last*

Enter the first name of the patient.First*

Enter the middle name of the patient.Middle

Enter the patient's date of birth (DOB) in
MM/DD/YYYY format. Click the calendar to
select a date.

DOB

The patient's age is calculated automatically
based on the entry in DOB.

Age

Select a gender value from the list. By default,
Unknown is selected.

Gender*

Enter the unique Medical Record Number
(MRN) that is assigned to each patient.

MRN*

If a patient's MRN is in the hospital's system,
the application fills the following fields:

> Last
> First
> DOB
> Age
> Gender

Note: The Update Patient Info button is
displayed only when the DAMR and UPID
system options are set to Yes. Click Update
Patient Info after you enter the MRN details.

Patient information from hospital systems

5. Enter required or optional information into the Visit Information section, as described in the
following table.

ActionField

Enter the diagnosis (Dx code) for the patient.
The Dx code is based on your hospital's
values.

Dx*

Select the facility.Facility*

Select the care level.Care Level*
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ActionField

Select the care service required.Care Service*

Select the patient class. The default is
Inpatient.

Patient Class*

Click to search for and select the admitting
physician's name.

Note: Depending on your settings, this field
might not be required.

Admitting Physician*

Click to search for and select the attending
physician's name.

Note: Depending on your system options,
this field might not be required in both the
Admission and Transfer requests.

Attending Physician*

Click to search for and select the referring
physician's name.

Referring Physician*

Enter the name of the caller.

Note: Depending on your settings, this field
might not be required.

Caller's Name*

Enter the phone number of the caller.

Note: Depending on your settings, this field
might not be required.

Caller's Number*

Enter the patient's insurance company.Insurance Company

Enter any authorization information for the
patient (for example, a code from the health
insurer).

Authorization

Based on the care level, select the unit.
Otherwise, this field is unavailable.

Unit Selection

Enter patient note information that cannot be
entered in other boxes.

Notes
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ActionField

Enter the admission date and time. By default,
the current date and time are displayed. To
change the date, click and select the date.
To change the time, click and select the
time.

Admit D/T*

Enter the organization that is the source of the
patient's admission.

Admit Source*

Select the medical condition of the patient.Patient Condition

Enter the current location of the patient.Patient Location

Enter the contact name for the patient (for
example, a relative).

Patient Contact Name

Select the contact's relationship to the patient.Contact's Relationship

Enter the phone number for the patient's
contact.

Contact's Number

Select the unit that is preferred for the patient.Preferred Unit

Select the priority of the bed request.Bed Request Priority

6. Click Next.
Patient Details Screen II of Direct Admit is displayed.
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7. (Optional) On Patient Details Screen II, click and select values for any field.
All fields on this window are optional. Fields are described in the following table.

Note: The fields on Patient Details Screen II are based on your
hospital's configuration and might vary from the fields described.

ActionField

Select multiple disability values for the patient.Disability

Select multiple values that describe the
protection plan and policies required to meet
the needs of the patient.

Security

Select the patient's condition level.Patient Condition

Select a value that describes the patient's need
for mobility assistance equipment.

Patient Mobility
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ActionField

Select multiple confidentiality details that apply
to the patient.

Confidentiality

Select a value that specifies the patient's risk
of falling.

Fall Risk

Select the type of room requested.Patient Preference

Select multiple contact isolation values.Contact Isolation

Select multiple droplet isolation values.Droplet Isolation

Select multiple airborne isolation values.Airborne Isolation

Select this box to specify that the patient is
receiving chemotherapy treatment.

Chemotherapy

Select the applicable health coverage.Insurance

Select this box if the patient needs to be
monitored and special equipment is needed.

Telemetry

8. Review the information entered for accuracy. Do one of the following:

> To correct information that was previously entered, click until you reach the window.
> Correct the information.

> When all corrections have been made, click to go to the Patient Details Screen
II again.

> To submit the request without reviewing or entering information on the Patient Needs Screen

III, click .
Patient Details Screen II closes, and the bed request for the direct-admit patient is submitted.
The new patient information is displayed on Portal View (you might have to scroll down to
view the new patient), and the patient's bed request is displayed on Bed Management
Worklist.

> To review or enter information on Patient Needs Screen III, click .
Patient Needs Screen III for Direct Admit is displayed. Based on information you entered
on the previous two windows, some check boxes might be selected.

June 23, 2022 | Allscripts Patient Flow 22.1 71
Bed Management User Guide
Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.

Direct Admit functionality



Note: The fields that are displayed on the Patient Needs Screen
III are based on your hospital's configuration and might differ from
the boxes on the window.

Figure 1: Direct Admit: Patient Needs Screen III

9. Do one of the following:

> If the information is correct and you are ready to submit the request, go to Step 9.
> If an item applies to the patient, but is not selected (for example, Near Nursing Station),

select the check box next to the item, and then go to Step 9.
> If an item is selected but does not apply to the patient (for example, Near Nursing Station),

clear the check box next to the item, and then go to Step 9.

> To correct information that was entered on previous windows, click until you reach
the window with the incorrect information.

> Correct the information.

> When all corrections have been made, scroll down and click until you reach the
Patient Needs Screen III.
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10. To submit the request, click .
Patient Needs Screen III closes and the bed request for the direct-admit patient is submitted.
The new patient information is displayed on Portal View.

Assign patients to beds with Ready to Move
To facilitate more precise and timely communication when placing patients in beds, use the Ready
to Move feature. When enabled for your organization, this feature integrates Sunrise™ Clinical
Manager and Allscripts® Access Manager to visually indicate the patient’s readiness to move to a
bed.

Before you begin
Verify the Ready to Move feature is enabled and you are assigned to the correct authorization
item.

The Ready to Move icon ( ) is unavailable until the patient's admission request is complete and
the admission icon ( ) is displayed.
When a patient is ready to be moved to a bed, a green background is displayed on the Bed
Management Worklist and the Pending In section on Unit View.

1. From Portal View, click under Pending Activity.
If an error occurs during communications between programs, an error message indicates that
the Ready to Move status could not be updated. The reason for the non-functioning move
request is also indicated in the error message. Error messages might include:

ProblemError message

The Medical Record Number (MRN) is null or
empty in the patient's record.

MRN not provided.

The Account Number was not provided.Account Number is not provided.

The FacilityHL7Code not provided.FacilityHL7Code not provided.

The UnitHL7Code is null or empty.UnitHL7Code not provided.

The username is null or empty.UserName not provided.

The unit does not exist in Access Manager for
the given UnitHL7Code.

Unit does not exist in AM.
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ProblemError message

The facility does not exist in Access Manager
for the given FacilityHL7Code.

Facility does not exist in AM.

The patient does not exist in Access Manager
for the given VisitNumber, MRN,
FacilityHL7Code, or UnitHL7Code.

Patient does not exist in AM.

When the move request is successful, the patient row background on Portal View turns green.

After you indicate that the patient is ready to be moved to a bed, that patient is also displayed
on Bed Management Worklist with a green background. If the patient is not assigned to a
bed, they are displayed in the Bed Control queue as awaiting a bed or unit reservation,
depending upon how your organization reserves beds.

2. From Bed Management Worklist, select Find Bed.
If necessary, use the applicable filters.
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3. Select a bed and then click Reserve.
After you reserve a patient to a bed, that patient is displayed with a green background on Unit
View in the Action Required section.

4. On the Action Required section, click Acknowledge.
The patient's bed information moves to Pending Arrival.

5. Click Arrive to indicate the patient is in the bed.
Process Patient Arrival opens.
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6. Select OK to return to the Unit View.
The patient row is no longer green. Also, the patient is removed from Portal View andBed
Management Worklist, but is displayed as assigned to the bed on Unit View.

Request patient transports
Create a transport request for a patient on Portal View.

A patient transport requires moving a specific patient to another area (for example, moving a
patient from Cardiology to Radiology for a test procedure). A material transport only moves items
associated to a patient (for example, medical records, lab specimens, or blood products). These
transport types for a patient are configurable and display as options, which can be selected in
Request Type on Transport Request.
The following steps use the example of a Discharge transport type. Depending on your
organization's setup, transport types vary and might have different fields.

1. On Portal View, verify that the applicable organization is selected in the Facl/Unit/Pod box. If
not, select another organization from the list.

2. Locate the patient in the list.

3. Click in the Pending Activity column.
The Transport Request window opens.

4. For Request Type, select a transport type from the list (for example, Discharge).
Examples of transport requests might include:

> Morgue
> Test Procedure
> Admission
> Discharge
> Transfer
> Equipment

5. Click Go.
Transport Request opens and is displayed with fields that are configured for the selected
transport type.

Note: The fields that display on Transport Request are based on your
hospital's configuration and might be different than the fields displayed
in this example.
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6. Under Request Information, select values for required fields, which are displayed with an
asterisk (*).

> Type: The request type that you selected. This field cannot be changed.
> Priority: By default, Routine is displayed. If you do not have the applicable permissions,

this field is not displayed.
> From and To fields

7. Select the type of transport leg.
A transport leg is the origin and destination of the patient or material. Options include:

> Stay with job: Specifies a single transport leg. By default, this value is selected.
> Roundtrip: Specifies that the materials make a round-trip leg. When you select this option,

a second row of fields is displayed for From and To.
> Permanent Move: Indicates that the patient transport is permanent.
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8. To designate the transport leg duration, complete the following steps:

a. For From, verify the origin location. If necessary, select another value.
By default, the current location of the patient is displayed.

b. For To, verify the destination location. If necessary, select another value.
If the transport type is configured to have a default value for To, then that location displays
in this field.

c. For Pick-up Time, verify that the date and time are correct.
The system calculates a suitable pick-up time based on your facility's configuration by default.
If necessary, update the information. When displayed, use any of these options:

> Click to select a date.

> Click to select a time.

> Click to unlock a field.

> Click to open Schedule, where you can view or change the transport request time.

> Click to remove a field.

d. If Roundtrip is selected, enter information into the From and To fields on the second row.
By default, the transport type's duration is added to the first leg's date and time to calculate
the second leg's date and time.

e. (Optional) To add another transport leg, click Add.

9. Enter information into any optional fields.

Click to select values from a list. If you do not have any information to enter in an optional
box, leave it blank. Examples of transport request fields are described in the following table.

ActionField

Select the region for the transport request. If
you do not have the applicable permissions,
this field is not displayed.

Region

If the transport request is a round-trip, select
this box for the transport personnel to stay with
the transport job. If this is a material transport
for the patient or is not a round-trip, this box is
not available (displayed in grey).

Stay with job
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ActionField

Select this box if the transport is for a
permanent move. If this is a round-trip, this box
is not available (displayed in grey).

Permanent Move

Any other scheduled appointments, including
a change bed request for the patient, are
displayed in this field. If there are none, the
field is blank.

Scheduled Appts.

A Mode of Transport (MOT) might display by
default, based on your facility's configuration.
To change the MOT, select another value from
MOT.

MOT

Select a personnel value from the list. By
default, Transporter is selected.

Personnel

Enter the number of personnel in the first Qty
field.

Qty

If necessary, select another personnel value
from the second Personnel.

Personnel

If necessary, enter the number of personnel in
the second Qty field.

Qty

Select the box next to any Equipment value
(for example, Pump or Telemetry Monitor).

Equipment

Select the box next to any Isolation value ( for
example, Airborne Isolation).

Isolation

Select the box next to any Requirements
value (for example, Female Only or Male
Only).

Requirements

Select the box next to any Materials value (for
example, Bed).

Materials

Enter any information about the transport into
the Notes box next to this icon.(Notes section icon

Select this box to make the note information
visible to all users, or clear the box to hide the
note from users.

Note visible for all users

Enter the phone number for the request.Phone
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10. Click Submit.
Transport Request closes and the patient transport is scheduled. The Portal View displays

the icon in the patient tile and in the Pending Activity column.

If the transport is round-trip or has multiple legs, a icon displays in the Pending Activity
column for each transport leg.

Request material transports
Create a transport request for materials on Portal View.

A patient transport requires moving a specific patient to another area (for example, moving a
patient from Cardiology to Radiology for a test procedure). A material transport only moves items
associated to a patient (for example, medical records, lab specimens, or blood products). These
transport types for a patient are configurable and display as options, which can be selected in
Request Type on Transport Request.
The following steps use the example of a Equipment transport type. Depending on your
organization's setup, transport types vary and might have different fields.

1. On Portal View, verify that the applicable organization is selected in the Facl/Unit/Pod box. If
not, select another organization from the list.

2. Locate the patient in the list.

3. Click in the Pending Activity column.
The Transport Request window opens.

4. For Request Type, select a materials transport type from the list (for example, Equipment).
5. Click Go.

Transport Request opens and is displayed with fields that are configured for the selected
transport type.

Note: The fields that display on Transport Request are based on your
hospital's configuration and might be different than the fields displayed
in this example.
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6. Under Request Information, select values for required fields, which are displayed with an
asterisk (*).

> Type: The request type that you selected. This field cannot be changed.
> Priority: By default, Routine is displayed. If you do not have the applicable permissions,

this field is not displayed.
> From and To fields

7. Select the type of transport leg.
A transport leg is the origin and destination of the patient or material. Options include:

> Stay with job: Specifies a single transport leg. By default, this value is selected.
> Roundtrip: Specifies that the materials make a round-trip leg. When you select this option,

a second row of fields is displayed for From and To.

8. To designate the transport leg duration, complete the following steps:
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a. For From, verify the origin location. If necessary, select another value.
By default, the current location of the patient is displayed.

b. For To, verify the destination location. If necessary, select another value.
If the transport type is configured to have a default value for To, then that location displays
in this field.

c. For Pick-up Time, verify that the date and time are correct.
The system calculates a suitable pick-up time based on your facility's configuration by default.
If necessary, update the information. When displayed, use any of these options:

> Click to select a date.

> Click to select a time.

> Click to unlock a field.

> Click to open Schedule, where you can view or change the transport request time.

> Click to remove a field.

d. If Roundtrip is selected, enter information into the From and To fields on the second row.
By default, the transport type's duration is added to the first leg's date and time to calculate
the second leg's date and time.

e. (Optional) To add another transport leg, click Add.

9. Enter information into any optional fields.

Click to select values from a list. If you do not have any information to enter in an optional
box, leave it blank. Examples of optional transport request fields are described in the following
table.

ActionField

Select the region for the transport request. If
you do not have the applicable permissions,
this field is not displayed.

Region

If the transport request is a round-trip, select
this box for the transport personnel to stay with
the transport job. If this is a material transport
for the patient or is not a round-trip, this box is
not available (displayed in grey).

Stay with job
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ActionField

Any other scheduled appointments, including
a change bed request for the patient, are
displayed in this field. If there are none, the
field is blank.

Scheduled Appts.

A Mode of Transport (MOT) might display by
default, based on your facility's configuration.
To change the MOT, select another value from
MOT.

MOT

Select a personnel value from the list. By
default, Transporter is selected.

Personnel

Enter the number of personnel in the first Qty
field.

Qty

If necessary, select another personnel value
from the second Personnel.

Personnel

If necessary, enter the number of personnel in
the second Qty field.

Qty

Select the box next to any Equipment value
(for example, Pump or Telemetry Monitor).

Equipment

Select the box next to any Isolation value ( for
example, Airborne Isolation).

Isolation

Select the box next to any Requirements
value (for example, Female Only or Male
Only).

Requirements

Select the box next to any Materials value (for
example, Bed).

Materials

Enter any information about the transport into
the Notes box next to this icon.(Notes section icon

Select this box to make the note information
visible to all users, or clear the box to hide the
note from users.

Note visible for all users

Enter the phone number for the request.Phone

10. Click Submit.
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Transport Request closes and the material transport is scheduled. The Portal View displays

the icon in the patient tile and in the Pending Activity column.

If the transport is round-trip or has multiple legs, a icon displays in the Pending Activity
column for each transport leg.

Edit transport requests
Edit a transport request for a patient or materials assigned to a patient on Portal View.

1. In the Bed Management module, access Portal View and locate the patient's record.

2. Click on the patient tile or under Pending Activity.

3. On the Transport window, click .
4. On Transport Request, update any of the required or optional fields.
5. To edit the transport leg, complete the following steps:

a. For From, select another origin value.
b. For To, select another destination value.
c. For Pick-up Time, edit the date and time.

The system calculates a suitable pick-up time based on your facility's configuration by default.
If necessary, update the information. When displayed, use any of these options:

> Click to select a date.

> Click to select a time.

> Click to unlock a field.

> Click to remove a field.

d. If Roundtrip is selected, edit information into the From and To fields on the second row.
By default, the transport type's duration is added to the first leg's date and time to calculate
the second leg's date and time.

e. (Optional) To add another transport leg, click Add.

6. To change the pick–up time on the patient's schedule, complete the following steps:

a. Click .
The Schedule window opens with the scheduled date and time for the request.
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b. To change the date and time of the transport leg on Schedule, complete any of the following
actions:

> Select a new interval value from Interval.
> Click and drag the transport leg information to the new date and time.
> Click Next Available Time to choose the next available time.

c. Click Save.
Schedule refreshes and the pick-up time changes for the transport request are displayed.

7. After you finish with edits, click Submit.
Transport Request closes and the updated transport request is rescheduled. The Portal View

displays the icon in the patient tile and the Pending Activity column.

If the transport is round-trip or has multiple legs, a icon displays in the Pending Activity
column for each transport leg.
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Request patient transfers
Request a patient transfer from the Portal View.

1. Verify that the applicable organization is selected in the Facl/Unit/Pod box. If not, select another
organization from the list.

2. Locate the patient in the list.

3. On the patient's row, click in Pending Activity.
Transfer Request opens on Patient Details Screen I. The fields that display on this window
are based on your hospital's configuration.

Note: Fields displayed in grey are not available for data entry.
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4. Enter information into all required fields, which are displayed with an asterisk (*).

Click to select values from a list. If you do not have any information to enter in an optional
box, leave it blank.

ActionField

Select the diagnosis (Dx) for the patient. The
diagnosis code is based on your hospital's
values.

Dx

Select facility of the portal, which is displayed
as the default value. Depending upon your
organization's configuration, this field might not
be editable.

Facility*

Select the patient's care level.Care Level*

Select the patient's care service.Care Service*

Select the patient type. By default, Inpatient
is selected.

Patient Class*

By default, the attending physician's name that
is selected at the time of admission is
displayed. If necessary, click to search for
and select the attending physician's name.

Attending*

Select the patient's medical condition.Patient Condition

Select the bed request priority.Bed Request Priority

Enter any additional patient note information.Notes

Displays the estimated date and time the
patient is to be transferred. By default, the
current date and time are displayed. To change
the date, click and select the date. To
change the time, click and select the time.

Est. Time

Select a unit for the patient.Preferred Unit

Select the bed class applicable to the patient.Bed Class

Based on the care level, you might be able to
select the unit. Otherwise, this option is
unavailable.

Unit Selection*

Select the reason for the patient transfer.Reason*

June 23, 2022 | Allscripts Patient Flow 22.1 87
Bed Management User Guide
Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.

Request patient transfers



ActionField

Select a mobility option.Patient Mobility

Select the fall risk option.Fall Risk

Select the applicable security options.Security

Select the applicable contact options.Contact Isolation

Select the applicable isolation options.Droplet Isolation

Select the applicable chemotherapy options.Chemotherapy

Select the applicable airborne isolation options.Airborne Isolation

Select this option if the patient must have
telemetry monitoring.

Telemetry

5. Scroll down and do one of the following:

> If more information is needed (for example, the patient requires isolation), go to Step 6.

> If no other information is needed, click .

Patient Details Screen I closes and Portal View is displayed. The Transfer icon ( ) and
a timer is displayed in the patient tile and Pending Activity column to indicate that the patient
has a pending transfer.

6. Click .
Transfer Request opens on Patient Needs Screen II. Information that is entered in the first
page might trigger a field to be selected on this window (for example, Private Room). The fields
that are displayed might be different that the boxes that are displayed on the following image.

88 Allscripts Patient Flow 22.1 | June 23, 2022
Bed Management User Guide

Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.

Chapter 4 Portal View workflows



7. If applicable, select any box to enter more data.
8. Review the information for accuracy and do one of the following:

> If the information is correct, go to Step 9.
> If the information is incorrect, enter the correct information.

9. Click

Patient Details Screen II closes, and Portal View is displayed. The transfer icon ( ) and a
timer is displayed in the patient tile and the Pending Activity column to indicate that the patient
has a pending transfer.

View pending request details
On Portal View, icons display on the patient tile and in the Pending Activity column to indicate
the type of pending request (such as for pending admissions). Clicking the icon displays some
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information for the pending request, which displays more icons to take specific actions, as shown
in the following illustration.

Figure 2: Pending Admission Details

Change pending requests
Change a pending transport, transfer, admission, or direct admit request for a patient by clicking

the associated icon on the patient row, for example, for a transfer request, which displays a
window with some patient details. Click the action on this window for example, .

To cancel a request, you can either click or you can click the Cancel button for that
request in the Pending Activity column on the patient row. A window then displays to request a
reason for the cancellation. Select a reason, click OK, and the request is canceled.
The example changes in this procedure are for a patient with a pending discharge request on
Portal View. You can cancel the discharge, enter changes to discharge information, or complete
the discharge for the patient. It is assumed that the applicable organization is selected in the
Facl/Unit/Pod box.

1. On the specific patient's row of information, click either in the patient tile or the Pending
Activity column.
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Pending Discharge is displayed.

Figure 3: Pending Discharge Window

2. Do one of the following:

> To cancel the pending discharge, go to Step 3.
> To edit the pending discharge information, go to Step 6.
> To depart a patient, go to Step 8.

3. Click .
Cancel is displayed to request confirmation.

Figure 4: Cancel Window

4. Click the Reason selection arrow and select a required cancellation reason.
The selected reason displays in the Reason box.

5. Click OK.
The pending discharge is canceled, and Cancel closes. Portal View displays the patient row,
and theDischarge icon and timer are removed from the patient tile and the Pending Activity
column.

6. To edit the discharge, click on Pending Discharge.

June 23, 2022 | Allscripts Patient Flow 22.1 91
Bed Management User Guide
Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.

Change pending requests



Pending Discharge for the patient is displayed.

Figure 5: Discharge and Milestones

7. Do one of the following:

> To change discharge information, enter the changes in the applicable boxes and click Save
and Close.
Pending Discharge closes and the information is saved. Portal View displays the patient
row, and the Discharge icon and timer still display in the patient tile and in the Pending
Activity column.

> To cancel the discharge, click Close.
Discharge closes and the discharge is canceled. Portal View displays the patient row, and
the Discharge icon and timer are removed from the patient tile and the Pending Activity
column.

> To complete the discharge (removing the pending characteristic), click Depart.
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Accept is displayed to request confirmation of the discharge.

Figure 6: Depart Window

> To confirm the discharge, click OK.

Note: When you click, you cannot cancel or make any other changes
to the discharge.

Portal View displays the patient row. All patient information is removed from the row, including
the Discharge icon and timer. The color of the patient tile changes to brown, indicating
that the bed is dirty and needs to be cleaned.

8. To depart the discharge, click on Pending Discharge.
Process Patient Departure for the patient is displayed.

Figure 7: Process Patient Departure

9. Do one of the following:

> To change the date or time, enter the change or click the calendar or time icons and select
the date or time. Then click OK to proceed with the departure.
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Process Patient Departure closes. The patient is departed (even if there was a future date
and time displayed), and the patient row is removed from Portal View.

> If the date and time are correct, click OK to proceed with the departure.
Process Patient Departure closes. The patient is departed (even if there was a future date
and time displayed), and the patient row is removed from Portal View.

> To cancel the discharge, click Cancel.
Process Patient Departure closes. The patient is not departed, and Portal View displays
the patient row.

94 Allscripts Patient Flow 22.1 | June 23, 2022
Bed Management User Guide

Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.

Chapter 4 Portal View workflows



Chapter 5

Unit View

Use Unit View to respond to bed requests from the Activity Pane. View, create, edit, or cancel
Bed Swap, Discharge, Move, Transfer, and Housekeeping requests. View bed details or create
bed cleaning requests, or view and change patient details.

To access Unit View, click Bed Management > Unit View in the left navigation pane.

Figure 8: Unit View

Based on your user authorizations, two graphical tools might be available to you. A Dashboard
Screen Header displays at the top ofUnit View, which lists the Key Performance Indicators (KPIs).

Click to view the floor plan for the selected unit.

Unit View-dashboard header
Use the dashboard header at the top of Unit View to view Key Performance Indicators (KPIs) for
facilities and the units or pods within a facility.

Figure 9: Unit View dashboard header

The dashboard header displays individual KPIs for the specific facility, unit, and pod displayed in
the Facility/Unit/Pod field. The colored oval indicates the status for that KPI. The number to the
right of the KPI label indicates a percentage or count (for example, IN:0 indicates that there are
zero incoming requests for that unit). If you select another unit, the KPIs refresh and display the
updated data for the unit.
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The information in the Dashboard Header is configurable by the Allscripts Patient Flow™

Implementation Team (not by the administration functions in Allscripts Patient Flow™). Also, security
for each KPI is configurable with the Admin Mode function for dashboards. For example, security
can be configured so that the view of unit information is restricted, but can also be set to bypass
to display overall facility information.
TheUnit View dashboard header contains several types of information as explained in the following
table.

DescriptionHeader value

When a facility is selected, displays the
percentage of the facility's beds that are
occupied. The expanded view displays separate
charts for OCC: % value by:

> Pod: The unit's occupancy percentage by pod
> Unit: The occupancy percentage by unit for

all units that you have access to in this facility
> Care Service: The unit's occupancy

percentage by the patient's Care Service

OCC: % value

Displays the number of pending incoming
requests for a bed in the facility’s unit. The
expanded view displays separate charts for:

> Pending In by Pod: The unit's number of
pending incoming requests by pod

> Pending In by Unit: The number of pending
incoming requests by unit for all units that
you have access to in this facility

> Pending In by Pt Care Service: The unit's
number of pending incoming requests by the
patient's Care Service

IN: numerical value
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DescriptionHeader value

The number of discharge workflows that are not
canceled, completed, or faulted (for example, a
discharge workflow that has a Pending
Discharge or an awaiting ADT confirmation
status). This view displays the number of
pending discharges for the unit. The expanded
view displays separate charts for:

> Pending DC by Pod: The unit's total number
of pending discharges by pod for today

> Pending DC by Hour: The unit's total number
of pending discharges by hour of day since
midnight

> Pending Tx Out by Pod: The unit's total
number of pending transfers out by pod for
today

> Pending Tx Out by Hour: The unit's total
number of pending transfers out by hour of
day since midnight

DC: numerical value

Any open transfer workflows where the status
is not Arrived or awaiting ADT confirmation
(or example, Not Completed). This view
shows the number of pending Transfers for the
unit. The expanded view displays separate
charts for:

> Pending Tx Out by Pod: The unit's total
number of pending transfers out by pod for
today

> Pending Tx Out by Hour: The unit's total
number of pending transfers out by hour of
day since midnight

> Pending DC by Pod: The unit's total number
of pending discharges by pod for today

> Pending DC by Hour: The unit's total number
of pending discharges by hour of day since
midnight

TX: numerical value

The number of occupied beds in the facility's
units or pods.

OCC: numerical value

June 23, 2022 | Allscripts Patient Flow 22.1 97
Bed Management User Guide
Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.

Unit View-dashboard header



View Patient Summary
To view Patient Summary, click a patient's name on Unit View. The window displays the patient's
Care Service, Care Level, Attributes, and Needs information.

If necessary, click Patient Details to open the Patient Details window, where you can view or
edit details for the patient.

Unit View-activity pane
Use the activity pane on Unit View to complete activities related to bed, transfer, or transport
requests. For example, swap beds between two patients, request a patient transfer, or change
the patient's transport.

Unit View-activity pane request icons
On the Unit View activity pane, use the icons related to patient Transfer, Transport, or Discharge
requests. If necessary, create a Bed Swap or Change Room/Bed request.

The following icons display in the Pending Activity column of the activity pane:
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> : Opens Transfer Request, where you can create a Transfer request for the patient or
update the patient's details.

> : Opens Transport Request, where you can create a Transport request for the patient.
> : Opens Discharge and Milestones, where you can create a Discharge request or enter

patient milestone information.
> : Expands the Bed Swap and Change Room/Bed options.

Click Bed Swap to open the Bed Swap window, where you can select another patient and
submit a Bed Swap request for the patient.
Click Change Room/Bed to open Change Room/Bed, where you can reassign the patient to
another bed location.

If a patient has an incomplete request, the icon for that type of request is unavailable and displays
in grey.
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Bed Details window
Use the Bed Details for a patient to view details such as the bed location, care level, care service,
and so on. To access Bed Details, click the bed ID in a patient tile.
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If the patient is in the bed, the Patient Information tab is displayed as the first tab. View details
such as the patient's attending physician, attributes, financial, or safety information. Complete
other actions from Bed Details:

> Click Patient Details on the Patient Information tab to view patient information.
> Click the Bed Turnover tab to create bed-cleaning requests.
> Click the Bed Closure tab to view the bed status or close a bed.
> Click the Attributes tab to view the bed attributes, such as the patient's gender or equipment

associated to the bed.

OnAttributes users with the Bed Details - Edit Attributes Tab selected on their auth role can select
or remove bed attributes as needs change. Saving these changes on Attributes also changes
the Bed/Room attributes in Admin.
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Change bed locations
From the Unit View activity pane, change a patient's current bed or room location to an open bed
in the same unit.

Before you begin
Verify the following:

> The patient does not need an isolation bed.
> The bed is not occupied by another patient. If so, you can use a bed swap workflow.
> The patient's unit is selected from Facility/Unit/Pod.

1. In the Bed Management module, click Unit View.
2. Locate the patient and click on the patient's activity pane.

The Bed Swap and Change Room/Bed options are displayed. If a patient is not eligible for a
bed change, the options are not available.

3. Click Change Room/Bed.
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Change Room/Bed opens.

4. From Select Bed, select a new patient bed.
5. Click OK.

The Intra-Unit Activity section displays for the patient.

6. To view the new bed location and any available actions, expand the section.
7. (Optional) Complete any of the following actions:

> To add notes to the activity request, click

.

> To indicate that the patient has arrived to the bed location, click .

The bed location change is completed, and the patient's information is removed from the
Intra-Unit Activity section. The patient's name displays with the new bed location. Also, the
patient tile displays diagonal lines, which indicates that Admission, Discharge, Transfer (ADT)
activity is pending. The The Waiting ADT Activity section displays the patient's name and
WADT.

Swap patient beds
From the Unit View activity pane, swap beds between two patients in the same unit.

Before you begin
Verify the following:

> The unit is selected from Facility/Unit/Pod.
> Two beds are occupied by patients and in the same unit.
> Both patients have the same care level selected in the unit.

1. In the Bed Management module, click Unit View.
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2. Locate the patient and click on the patient's activity pane.
The Bed Swap and Change Room/Bed options are displayed. If a patient is not eligible for a
bed change, the options are not available.

3. Click Bed Swap.
The Bed Swap window displays.

4. From Select Patient, select the patient's name with whom to swap the bed.
The selected patient's name displays in the Select Patient field.

Note: If another user attempts a bed swap at the same time, an error
message indicates that a bed swap or room change is active for the
patient.

5. Click OK.
TheBed Swapwindow closes. The Intra-Unit Activity section displays the two patients whose
beds were swapped.

6. Expand the Intra-Unit Activity section to view the bed details and possible options.
7. (Optional) Complete any of the following actions:

> To add notes to the activity request, click

.

> To indicate that the two patients arrived to their new bed locations, click for each
patient.

The bed swap is completed and the information is removed for both patients from the Intra-Unit
Activity section. The patients' names display in the new bed location, and the patient tiles
display diagonal lines, which indicates pending Admission, Discharge, and Transfer (ADT)
activity. The Waiting ADT Activity section displays the patients' names and WADT.
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Request bed cleanings
From Bed Details, request that a patient's bed be cleaned.

1. In the Bed Management module, click Unit View.
If necessary, verify that the patient's unit displays in Facility/Unit/Pod.

2. On the patient's tile, click the bed ID.
Bed Details is displayed.

3. Click the Bed Turnover tab.

4. For Clean Type, select a bed cleaning job type.

Note: For sequential bed cleaning jobs, such as UVIsolation, the
second part of the job does not display on the Bed Turnover Worklist
until the first part is completed. Also, the bed tile does not indicate a
clean status (green) until the second part of the sequential cleaning job
is complete.

5. For Clean Priority, select a cleaning priority value.
You must be assigned to the correct permissions to select values from this list.

6. Click Submit.
The bed cleaning information is saved and Bed Details closes. The color of the bed tile on Unit
View changes to brown, which indicates a dirty bed status.
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Change bed statuses to Closed
From Bed Details, update a bed status to Closed. For example, a bed repair might need to be
moved to a Closed status.

Before you begin
Verify that other bed statuses are cancelled before you change the bed status to Closed (for
example, a Dirty,

1. In the Bed Management module, click Unit View.
If necessary, verify that the patient's unit displays in Facility/Unit/Pod.

2. On the patient's tile, click the bed ID.
Bed Details is displayed.

3. Click the Bed Closure tab.
4. From Closed Bed Reason select a reason that explains why you are closing the bed job.
5. (Optional) To change the default current date or time to start the bed closure, enter the change

in Closed Bed Timeframe Start.
If necessary, click the calendar or clock to select a start date and time.

6. Enter the end date or time in Closed Bed Timeframe End.
If necessary, click the calendar or clock to select an end date and time.
The End date and time must be later than the Start date or time.

7. Click Schedule Close.
The information is saved and Bed Status closes. When the date and time for the scheduled
close is reached, the color of the patient tile on Unit View changes to black and displays the
ADT ID reason for the closed bed status.
If the bed is occupied at the scheduled time of the bed close, the bed closes when the patient
has departed the bed.

View transfer information
To view information for patient transfers on Unit View, click for a patient under the Pending
Activity column.

Note: The Transfer Center module must be enabled for your organization.
Otherwise, the information is not available.
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Request patient transfers
From Unit View, submit a transfer request for a patient.

Before you begin
Verify that your organization is enabled for the Transfer module and the transfer icon ( ) displays
in the patient's record.

1. In the Bed Management module, click Unit View.
2. Locate the patient in the list.

If necessary, verify that the patient's unit displays in Facility/Unit/Pod. If not, select the correct
unit.

3. Click under Pending Activity.
Transfer Request opens on Patient Details Screen I. The fields that display on this window
are based on your hospital's configuration.

Note: Fields displayed in grey are not available, and you cannot enter
information into these fields.

4. Verify or update information in all required or optional fields on Patient Details Screen I.
Required fields are displayed with an asterisk (*). If you don't have information entered into a
required field and click Next or Submit, a warning icon ( ) displays.

5. If more information is needed for the patient transfer, click Next.
Patient Needs Screens II opens, where you can enter details such as equipment or isolation
needs for the patient.
Information that you enter in Patient Details Screen I might trigger a field on Patient Needs
Screens II (for example, Private Room). Also, the fields on this window might vary.

6. After you enter the necessary transfer request information on Patient Details Screen I or
Patient Needs Screens II, click Submit.

Unit View is displayed, and the transfer icon changes to , which indicates that a transfer
request was submitted. Also, a timer is displayed in the patient tile and the Pending Activity
column to indicate that the patient has a pending transfer.
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Change pending Transport, Transfer, or Discharge
requests
Change a pending transport, transfer, or discharge request for a patient by clicking the associated
icon on the patient row.

For example, click for a transfer request, which displays a page with some patient details and
enables you to select an action. Click the applicable action (for example, ). To cancel a

request, click on this window or click Cancel for that request in Pending Activity on the

patient row. A page is displayed to select a reason for the cancellation. Click to cancel the
request.
The example changes in this procedure are for a patient with a pending discharge request in Unit
View. On Facl/Unit/Pod, select the applicable unit and then one of the following actions:

> Cancel the discharge
> Edit discharge information
> Complete the discharge
> Depart the patient
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1. On the patient row, click in the Patient Tile or Pending Activity, and select the applicable
action from the patient window.

Figure 10: Discharge and Milestones

2. Do one of the following:

> To cancel the pending discharge, go to Step 3.
> To depart the patient, go to Step 6.
> To edit the pending discharge information, go to Step 9.

3. Click Cancel.

Figure 11: Cancel
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4. Select a cancellation reason.

5. Click .
The pending discharge is cancelled, and Cancel closes. Unit View displays the patient row,
and and timer are removed from the Patient Tile and Pending Activity.

6. Click .

Figure 12: Discharge and Milestones

7. Click Depart.

Figure 13: Depart

8. Click OK to confirm that you want to discharge the patient.
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Process Patient Departure closes and the patient is departed. Unit View displays the patient
row. All patient information is removed from the row, including and timer. The Patient Tile
color changes to brown, indicating that the bed is dirty and needs to be cleaned.

9. To edit discharge information on the Details tab, enter or select the changes in the applicable
boxes, which are explained in the following table.

PurposeData

The date of the pending discharge is displayed
by default. To change the date, click
(Calendar popup) and select a date.

Discharge Date*

The time of the discharge. Enter the time or

click (time view popup tool) and select the
time. To enter a general time, select Morning,
Evening, or Afternoon.

Note: You cannot select a time in the future
to discharge a patient.

Discharge Time

The type of discharge.Discharge Type*

This box is available only for certainDischarge
Type options. If applicable, select the location
from where the patient is discharged.

Discharge To

The name of the discharge physician. You can
start entering the physician's name to narrow
the list of available options.

Discharge Physician

The exact month, day, and year that death
occurred.
The exact time of death, according to local
time.

Death Date/Time

The reason that resulted in death.Cause of Death

Manage milestones for the discharge. The
Manage Milestones tab is displayed after you

click .

Manage Milestones

Select if the discharge is under physician
orders.

Physician Orders

Enter any notes associated with the discharge.Notes
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PurposeData

If this box is selected (default), any notes are
visible for all users. Clear the box to make the
note private.

Note visible to all users

10. Click .
Pending Discharge closes and the information is saved. Unit View displays the patient row,
and the icon and timer are still displayed in the Patient Tile and in Pending Activity.

Request a patient transport or a material transport for a patient
Requesting a patient transport or a material transport for a patient using Unit View is similar to
requesting it using Portal View.
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Request a pending discharge for a patient
A request for a pending patient discharge using Unit View is similar to a Portal View request.

1. On a patient row of information, click in the Patient Tile or in Pending Activity.

Figure 14: Discharge and Milestones

2. Select Discharge Time, Discharge Type, Discharge Physician, Death Date/Time (if
applicable) and enter any Notes.
You can start entering the physician’s name in Discharge Physician to reduce the list of
available physicians to select.

3. Click Pending.
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Functions associated with a Bed ID
Clicking Bed ID on a patient tile icon displays Bed Details. If the bed is occupied by a patient, the
Patient Information, Status, and Attributes tabs display. If a bed is occupied by a patient, the
Patient Information, Bed Turnover, Bed Closure, and Attributes tabs display. If a bed is not
occupied only the Bed Turnover, Bed Closure, and Attributes tabs display.

Functions associated with the On/Off Floor indicator
The On/Off Floor indicator on the right of the Patient Tile icon shows whether the patient is actually
in the assigned bed or is in another location. If On displays, then the patient is in the assigned
bed. If another location displays, for example, RAD for Radiation, then the patient is in that off-floor
location and not in the assigned bed. The following procedures explain how to move a patient off
the floor to another location and then to return the patient back on the floor to the assigned bed.

If a Transfer Request exists for the patient, as indicated by the Transfer icon or in the
Pending Activity column, and you are moving the patient to a location (organization) available on
the Portal View, then you have the option of releasing the bed automatically when you move the
patient off floor.

Move a patient off floor
To move a patient from the assigned bed to another location off floor, follow the procedure following.
It is assumed that the appropriate unit is selected in the Unit box.

1. Navigate to the specific patient's row of information.
If the patient is in the assigned bed, On displays on the right of the patient tile icon.

Figure 15: Patient Information Window

2. Click On to the right of the patient tile icon.
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Move Patient Off Floor is displayed.

Figure 16: Move Patient Off Floor

3. Click Location to select the off-floor location.
The name of the off-floor location displays in the Location box. To change the default current
date and time to begin the off-floor activity, enter the change in the Off Floor Date Time box.
Alternatively, you can click the calendar icon and select a date and the time icon and select a
time.
The date and time display in the Off Floor Date Time box.

4. Click the time icon on the Estimated Arrival Back Date Time box and select a time. The time
must be later than the off floor date and time.
The selected time and the current date display in the Estimated Arrival Back Date Time box.
If the current date is not correct, you can enter the date or click the calendar icon and select a
date.

5. Click OK.
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Move Patient Off Floor closes. The abbreviation for the off-floor location, for example, RAD,
displays next to the patient tile icon as shown in the following figure. The time when the patient
is expected to return is displayed in the following figure of off-floor location.

Figure 17: Patient Information Window

Figure 18: Move Patient Off Floor

Move a patient back on floor

To move a patient from the off-floor location back to the assigned bed on the floor, perform the
following procedure. If the patient was moved off floor to a Facl/Unit/Pod location on Portal View,
then the patient cannot be moved back on the floor using this procedure. It is assumed that the
applicable unit is selected in the Unit box.

1. Navigate to the specific patient's row of information.
If the patient is off the floor, the abbreviation for the off-floor location displays next to the patient
tile icon.

Figure 19: Patient On Floor

Figure 20: Patient On Floor

2. Click the abbreviation for the off-floor location, for example, RAD.
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Move Patient On Floor opens, requesting you confirm the move of the patient.

Figure 21: Move Patient On Floor

3. Click .
Move Patient Off Floor, and On displays next to the patient tile icon to indicate that the patient
is back on the floor in the assigned bed location.

Figure 22: Patient Information

Figure 23: Patient Information

Unit View-unit activity sections
Unit View is the only page that displays a unit activity section. Use these sections to view patient
activities for the selected unit in the Facl/Unit/Pod list.

Four types of activities are tracked in the unit activity sections, which include:

> Action Required
> Pending Arrival
> Intra-Unit Activity
> Waiting ADT Activity
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If any of these types of activities are pending, the section expands slightly to display the patient's
name and a few other details. The number of each activity type is displayed in parentheses on the
right of the section heading.
The following image displays an example of the Waiting ADT Activity section, in which three
activities are pending.

If the activity section is in the collapsed view, click to expand the view or click to collapse
the view and hide the details.
To view or take action on activity information, click the available options in the window. For example,
the following image demonstrates the Pending Arrival section with the Notes, Arrive, Edit, and
Cancel options enabled.
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Action Required section
Use the Action Required section on Unit View to respond to a Bed Reservation request.

Your hospital can configure bed reservation requests that bypass the Action Required section
and instead display directly on the Pending Arrival section.
When patient information displays in this section, expand the section and display the possible
responses to the bed reservation. Response options include:

>
>

>

>

Acknowledge bed requests
From the Action Required section, acknowledge a bed request.

1. On the Bed Management module, click Unit View.
2. Expand the Action Required section.

The section expands and displays the available actions.
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Figure 24:

3. To acknowledge the bed request for the patient, click Acknowledge.
The bed request is acknowledged and the patient information moves to the Pending Arrival
section.

Change bed assignments
From the Action Required section, change a patient's bed assignment.

These steps assume that the patient is assigned to a bed.

1. In the Bed Management module, click Unit View.
2. Expand the Action Required section.
3. Click Edit.

Bed Assignment opens and is displayed with a list of available beds. The bed identifier includes
the unit, room, and bed location.
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4. To select a different bed, expand the Select list and choose another bed.
The different bed assignments, including those with a discharge or transfer (outbound) workflow,
display in the Bed Assignment field.

5. Click Assign.
Bed Assignment closes. The patient's new bed assignment displays in Action Required, as
demonstrated in the following image.

6. Expand the section and verify that the bed assignment for the patient is changed.
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Reject bed reservations
From the Action Required section, reject a patient's bed reservation.

These steps assume that a bed request is in progress.

1. In the Bed Management module, click Unit View.
2. Expand the Action Required section.

3. To reject the patient's bed reservation, click Reject.
4. On the Reject window, select a reason for the bed reservation rejection.

The rejection reason displays in the Reason field.

5. Click OK.
Reject closes, and the bed reservation is rejected. The bed information is removed from
theAction Required section. Also, the patient displays in the Bed Management Worklist
without a bed reservation.
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Pending Arrival section
Use the Pending Arrival section on Unit View to specify that the patient has arrived to their
assigned bed, or to update or cancel the bed reservation. If necessary, add notes to the bed
request.

Expand the Pending Arrival section to display the following options:

>

>
>

>

Manage pending arrivals
On the Pending Arrival section onUnit View, specify that the patient has arrived to their assigned
bed, update the bed request, or cancel the bed reservation. If necessary, add notes to the bed
request.

1. On the Bed Management module, click Unit View.
2. Expand the Pending Arrival section.
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The row expands and displays the available actions, as demonstrated in the following image.

Figure 25: Pending Arrival

Figure 26: Pending Arrival

3. (Optional) If necessary, use any of the optional actions:

> To add notes to the bed reservation, click .

> To edit the bed reservation, click .

> To cancel the bed reservation, click .

4. To specify that the patient has arrived to their assigned bed location, click .
Process Patient Arrival opens with a confirmation message.
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5. (Optional) If necessary, click the calendar or clock icons to update the date and time of the
arrival.

6. Click OK.
The patient is designated as arrived to the bed assignment, and the information is removed
from the Pending Arrival section. The updated information moves to the bed location on Unit
View and displays in the patient list. The patient information also displays in the Waiting ADT
Activity section.

Cancel bed reservations
1. On the Bed Management module, click Unit View.
2. Expand the Pending Arrival section.

3. To cancel the bed reservation for the patient, click .
The Cancel window opens, where you must select a reason to cancel the reservation.

4. From Reason, select a reason that explains why you are canceling the bed reservation.
The reason displays in the Reason field.

5. Click OK.
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The bed reservation is cancelled. The patient's information moves from the Pending Arrival
section to the Action Required section, where the patient is reserved to unit, but not to a
specific bed. At this point, the bed request can be cancelled or a different bed can be assigned.

Intra-Unit Activity section
Use the Intra-Unit Activity section onUnit View to view and manageChange Room/Bed (Move)
or Bed Swap request activities.

A patient's information displays in Intra-Unit Activity only when a Change Room/Bed (Move)
request or Bed Swap request is active.
Expand the section to display the response options to the bed request. Complete any of the
following options:

> Click to change the patient to arrived for a Change Room/Bed (Move) request.
One patient displays in the Intra-Unit Activity section for the request.

> Click to change the patient to arrived for a Bed Swap request.
Two patients display in the Intra-Unit Activity section for the Bed Swap request.

> Click to cancel any Change Room/Bed (Move) or Bed Swap request activities.

When aChange Room/Bed (Move) orBed Swap activity is completed, theWaiting ADTActivity
section displays the patient information (one patient for a Change Room/Bed (Move) and two
patients for Bed Swap) as Direct Admit activity. Diagonal lines display at the top the patient tile,
which indicates that an Admission, Discharge, Transfer (ADT) activity is pending.

Arrive patients to beds
From the Intra-Unit Activity section on Unit View, indicate that a patient has arrived to their bed
location assignment.

These steps assume that the patient is assigned to a bed location and a Change Room/Bed
(Move) request is active.

1. In the Bed Management module, click Unit View.
2. Expand the Intra-Unit Activity section.

The row expands and displays the available actions. For aChange Room/Bed (Move) request,
the section displays as demonstrated in the following image.
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3. Click .
The Change Room/Bed (Move) request completes, and the updated information displays on
Unit View. The patient's information is reassigned to the new bed location and removed from
the Intra-Unit Activity section.
The Waiting ADT Activity section displays the patient information as a Direct Admit activity.
Diagonal lines display on the patient's tile, which indicates that an Admission, Discharge,
Transfer (ADT) activity is pending.

Arrive patients for bed swaps
From the Intra-Unit Activity section on Unit View, indicate that the patients have arrived to their
new beds after a bed swap.

These steps assume that two patients are assigned to beds and a Bed Swap request is active.

1. On the Bed Management module, click Unit View.
2. Expand the Intra-Unit Activity section.

The row expands and displays the available actions. For a Bed Swap request, the section
displays both patients as demonstrated in the following image.

3. Click for each patient.
The Bed Request request completes, the patient information is removed from Intra-Unit
Activity, and the updated information displays on Unit View.
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The Waiting ADT Activity section displays the information for both patients on as a Direct
Admit activity. Diagonal lines display in the patient tile of both patients, which indicates that an
Admission, Discharge, Transfer (ADT) activity is pending.
For a Bed Swap activity, Unit View displays the two patients in the new bed locations as
demonstrated in the following image.

Cancel Change Room/Bed (Move) or Bed Swap requests
From the Intra-Unit Activity section on Unit View, cancel a request for a bed location change or
cancel a request for two patients to swap beds.

These steps assume that a Change Room/Bed (Move) or Bed Swap request is active.

1. In the Bed Management module, click Unit View.
2. Expand the Intra-Unit Activity section.
3. Click inside a specific patient row, but not the patient's name, to expand the row.

The row expands and displays the available actions. For aChange Room/Bed (Move) request,
only one patient is displayed. For a Bed Swap request, the two patients to swap rooms or beds
are displayed.

4. To cancel the request:

You can only click one time for one patient, irregardless of the request type.

> For a Change Room/Bed (Move) request, click for the patient.

> For a Bed Swap request, click for each patient.

The Cancel window opens, where you must select a reason to cancel the request.
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5. For Reason, select a value from the list.
6. Click OK.

The Change Room/Bed (Move) or Bed Swap request is cancelled. The information for the
patient is removed from the Intra–Unit Activity section, and the patient remains in the current
bed location.

Waiting ADT Activity section
Use the view-only Waiting ADT Activity section on Unit View to monitor recent patient activities
that were completed by Allscripts Patient Flow™, but are not yet processed in the hospital's
Admission, Discharge, Transfer (ADT) system.

When a patient has a pending ADT activity, diagonal lines display on a patient's tile. When the
patient's ADT activities are completed, the diagonal lines are removed and the patient's information
is removed from the Waiting ADT Activity section. The following image displays the Waiting
ADT Activity section and pending ADT activity on the patient's tile.
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Floor Plan
The Floor Plan displays the rooms and bed locations of a specified unit in a bird's-eye or overhead
view, enabling you to view the rooms and beds in a more graphical way, similar to an architectural
diagram.

The Patient Tiles on Floor Plan display the bed locations and occupancy or availability of the
beds.
You can access the Floor Plan by clicking Floor Plan on the left navigation pane or by clicking

(Floor Plan) from the Unit View, For optimal viewing, use a large monitor.

Note: You can return to Unit View from Floor Plan by clicking (Unit
View) or by clicking Unit View from the left navigation pane.

Use the Floor Plan's functions
This section describes the functions you can perform from Floor Plan.

The following procedures assume Floor Plan is displayed. Prior to starting these procedures, you
must click Facl/Unit/Pod on Floor Plan and select the applicable unit to display the unit's Floor
Plan.
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Use the Manual Scale function
The Manual Scale function enables you to resize the Floor Plan manually.

1. Access the Floor Plan by clicking Floor Plan from the left navigation pane or by clicking
(Floor Plan) on Unit View.

Figure 27: Floor Plan Window

2. To resize the Floor Plan, click (Manual Scale).
The page changes scale slightly, and the Manual Scale is available. You can click and drag

to the right to increase room size and decrease the number of beds
displayed or to the left to decrease room size and increase the number of beds displayed.
Depending on the scale, scroll bars might be displayed. Use these scroll bars to move around
the Floor Plan and view different beds.

3. To exit the Manual Scale feature and reset the scale back to its original setting, click (Best
Fit).
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Use the View options
You can change the Floor Plan view by selecting or clearing View Options. Selecting View
Options displays all room attributes and patient indicators on the Floor Plan.

1. Click (View Options) at the top right of Floor Plan.
View Options becomes enabled and displays all room attributes and patient indicators.

Use the Legend function
You can use the Legend function on Floor Plan to view beds with specific statuses, rooms with
specific attributes, or patient indicators.

1. Click (Legend) in Floor Plan.
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The Legend panes (for example, Bed Status) is displayed.

Figure 28: Bed Status and Room Attributes

2. Do one of the following:

> To view beds with a specific status, click the status in Bed Status.
> To view rooms with a specific room attribute, click the attribute in Room Attributes.
> To view patients with a specific status, click the attribute in Patient Indicators.
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If any rooms have that status, for example, Positive Pressure, the rooms with that bed status
are highlighted.

Figure 29: Floor Plan View

3. To clear a selection, click at the bottom left.
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4. To collapse a pane, click on the top right of the specific pane, for example, Room Attributes.
This action expands other panes (for example, Bed Status) to view more available options.

Figure 30: Bed Status Colors

Use the Workflows function
The Workflows function enables you to view patients in the Acknowledge, Pending Arrival, and
Intra–Unit Activity, and Waiting ADT Activity panes.

1. Click (Workflows button) on Floor Plan.
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Acknowledge, Pending Arrival, and Intra–Unit Activity, and Waiting ADT Activity display
on the right of the Floor Plan page. Any activity in the panes is shown.

Figure 31: Floor Plan Window

2. To view more details, click the patient's row.
The patient's row expands to show more details.

Figure 32: Intra–Unit Activity

3. To perform an action for the patient, click the applicable button at the bottom of the pane, for
example, .
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What happens next depends on the action taken. If was clicked, the patient arrives in
the applicable bed. Then Waiting ADT Activity displays the patient's activity.

Figure 33: Waiting ADT Activity

View the Bed or Patient details
You can click the bed ID in the patient tile to view more details. If a bed is unoccupied, Bed Details
displays information about the bed; if a bed is occupied, Bed Details also displays information
about the patient.

1. To view details, click the bed ID on the patient tile.
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If the bed is unoccupied,Bed Details is displayed. TheBed Turnover,Bed Closure,Attributes
tabs are displayed.

Figure 34: Bed Details Window

Figure 35: Bed Details Window

If the bed is occupied, Bed Details is displayed. The Patient Information tab displays the
patient's name, age, date of birth. Bed Turnover, Bed Closure, Attributes tab is displayed.
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The view-only Attributes tab displays the room's attributes. Clicking Patient Details
displays Patient Details.

Figure 36: Bed Details Window
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Figure 37: Bed Details Window

2. Click .
Bed Details closes and Floor Plan is displayed.
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Chapter 6

Pre–Admissions Worklist

Information for pre–admission patients transmitted through HL7 messages display on
Pre–Admissions Worklist. Pending admission requests viewed, edited, or canceled. External
organizations, such as a doctor's office, might provide information for pre–admission patients, and
hospital personnel can enter more details using this window. Pre–Admissions Worklist can also
be used to create, edit, or cancel bed requests as well as viewing request details.Notes is available
for patients for pending admission and bed requests.

Access Pre-Admissions Worklist
To access Pre-Admissions Worklist, click Bed Management > Pre-Admissions Worklist in
the left navigation pane.

Functions on the Pre-Admissions Worklist
The Pre-Admissions Worklist displays a list of patients for which admission requests have been
created.

Patient names are displayed on the patient list along other information such as a diagnosis and
age, which are provided by the external organization. If a patient on Pre-Admissions Worklist
has a pending admission, a Pending Admission icon is displayed in the patient tile. A timer
is associated with the pending admission status and is displayed in the patient tile (for example,
10M (10 minutes)). If you have the applicable permissions, you can view or edit patient details,
edit or cancel the pending admission request, or create a bed request.

Select organizations
If your organization has multiple facilities, all that you have access to are displayed by default in
theOrganization box. Pre-AdmissionsWorklist displays the patient information associated with
each facility shown in this box. The Organization box on Pre-Admissions Worklist is limited to
facilities. You can make changes in the Organization box by performing the following steps.

1. Click (selection arrow) on Pre-Admissions Worklist.
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Pre-Admissions Worklist displays the organizations you can access.

Figure 38: Pre-Admissions Worklist

2. Do 1 of the following:

> To expand the Organization list to view more organizations, click (Expand button).
The Organization list expands to show more organizations. The expand button changes to

a collapse button , which can be clicked to collapse the selection list.

> To remove all check marks from the boxes, click (Clear All button).
All check marks are removed.

> To insert check marks in all boxes, click (Select All button).
Check marks are inserted in all boxes.

> To clear 1 organization, click the specific organization's box. The check mark is removed
from the box, and the organization is cleared.

> To select 1 organization, click the specific organization's box. A check mark is inserted in
the box, and the organization is selected.

3. Click (Update Work list button).
The changes are saved and the organization list closes. Pre-Admissions Worklist refreshes
to display the patient information associated with the selected organizations displayed on the
list.

Note: After you make changes in the organization list, do not use
Refresh before clicking Update Worklist. If you do, the changes you
made in the organization list are not saved and the previous selections
in Organization are shown.
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View details of a Pending Admission request
To view details for a pending admission request, complete the following tasks.

1. Click (the pending admission icon) in the patient tile or the Requests column on the specific
patient row.
Pending Admission displays a few bed request details.

Figure 39: Pending Admission Window

2. Do 1 of the following:

> To view more details or edit the bed request information, click on Pending Admission.
> Patient Details Screen I for the pending admission request displays. To edit information on

the Admission Request wizard.

— To close Pending Admission, click outside the page or click .
Pending Admission page closes.

Edit a Pending Admission request
To edit the pending admission request for the patient, follow the following procedure.

1. Click (pending admission icon) in the patient tile or the Requests column on the specific
patient row.
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Pending Admission displays a few request details.

Figure 40: Pending Admission Window

2. Click .
Patient Details Screen I for the pending admission request is displayed.

Figure 41: Admission Request: Patient Details Screen I

3. Do one of the following:

> If you want to update the date or time in Est. Time, go to Step 4.
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> If you want to update any other boxes, go to Step 6.

4. To update the date or time in Est. Time, click .
Est. Time is displayed.

Figure 42: Est. Time Window

5. Do one of the following:

> To change the date, type the change in Est. Time or click the calendar icon and select the
date.

> To change the time, type the change in Est. Time or click the clock icon and select the time.
> Click the Estimated Time Change Reason arrow and select a reason.
> Click OK.

Est. Time closes. The updated date or time displays in Est. Time on the Patient Details
Screen I for the pending Admission Request.

6. Enter the applicable changes in the other boxes on the Patient Details Screen I.
7. Do one of the following:

> If you are finished entering changes and want to submit the pending admission request to
the same facility, scroll down and click Submit.
Patient Details Screen I closes. Pre-AdmissionsWorklist continues to display the patient

row with (pending admission icon) in the patient tile and in the Requests column.
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8. If you want to enter more information for the patient, scroll down and click Next.
ThePatient Needs Screen II of theAdmissionRequestwizard displayed. Based on information
entered previously, boxes on the page might have check marks.

Figure 43: Admission Request: Patient Needs Screen II

9. Do one of the following:

> If the information on the page is correct, go to Step 10.
> If an item applies to the patient, but does not have a check mark, for example, Telemetry

Monitor, click the box next to the item to insert a check mark. Go to Step 10.
> If an item has a check mark, but the item does not apply to the patient, for example, Telemetry

Monitor, click the box next to the item to remove the check mark. Go to Step 10.
> To correct information entered on the previous window, click Back.

— Enter the correct information in the boxes.

10. Do one of the following:

> If you are finished entering changes and want to submit the pending admission request to
the same facility, scroll down and click Submit.
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Patient Needs Screen II closes. Pre-AdmissionsWorklist continues to display the patient

row with a Pending Admission icon (a Pending Admission icon) in the patient tile and
in the Requests column.

> If the information is correct and you want to submit the pending admission request to the
same facility, click Submit.
Patient Details Screen II closes. Pre-AdmissionsWorklist continues to display the patient

row with (a Pending Admission icon) in the patient tile and in the Requests column.

Cancel a pending admission request
To cancel a pending admission request for a patient (as indicated by the pending admission icon

), follow the procedure. You might have to scroll up or down to find the patient.

1. On the right of the patient's row of information, click the Cancel button. (You can also click

on Pending Admission.)
Cancel is displayed.

Figure 44: Cancel Window

2. Click the Reason arrow and select a required reason.
The reason displays in Reason.
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3. Click to confirm the cancellation.

Cancel closes and the request is canceled. The pending admission icon is removed from
the patient tile and the Requests column in the patient's row of information.
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Chapter 7

Bed Management Worklist

This topic describes the Bed Management Worklist.

Bed Management Worklist uses an automated Intelligent Matching Engine (IME) process to find
suitable beds for patients. If no match is found using the automated process, the IME process can
be performed manually. Functions on this window include creating direct admit requests, reserving
a bed, canceling or rejecting a reservation, placing a hold on a bed, or canceling a hold. You can
also view the status of requests, as well as Patient Details and Patient History.

Access Bed Management Worklist
This topic describes how to navigate to the Bed Management Worklist.

To access Bed Management Worklist, click Bed Management > Bed Management Worklist
in the left navigation pane.
Bed Management Worklist is displayed.

Figure 45: Bed Management Worklist
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Buttons on Bed Management Worklist
The following table explains the functions of the buttons in the Assignment column on Bed
Management Worklist.

PurposeButton/Icon

Click this button to create a note or view notes
that were previously created. If a note has not
yet been created, the plus sign is displayed in
the Notes icon.

or

Click this button to display the applicable request
window (for example, the Admission Request
window), where you can enter changes to the
request.

Click the More Suggestions link to display the
Manual Search window where you can make
changes to the patient's needs and care service.
You can search for more bed matches or
manually run the IME process for the specific
bed request. This link is not displayed if a bed
reservation or bed hold has been made.

More Suggestions

If the window is in Unit search mode, click this
button to display theUnit Searchwindow where
you can make changes to the patient's
organizations, care service, and care level to
search for more unit matches. This button is not
displayed if a bed reservation or bed hold has
been made.

This button is displayed only if multiple bed
matches are displayed in the Assignment column
for the patient. Click this button to display Mixed
Comparison to compare the bed attributes of
the bed matches.

This button is displayed only if a request was
referred to the facility. Click this button to display
the Reject window, where you must select a
reason to reject the bed request.
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PurposeButton/Icon

This button is displayed only if a bed reservation
is made to a unit. Click this button to display the
Rejectwindow, where you must select a reason
to reject the request.

Click this button to display the Cancel window,
where you must select a cancellation reason to
cancel the request.

The Cancel Reserve button is displayed on the
patient row in the Assignment column only if a
bed reservation or hold was made. Click this
button to cancel the bed reservation or hold.

The Reserve button is displayed on the patient
row in the Assignment column if a bed (or pod)
that matches the bed request criteria is available.
Click the Reserve button that is associated with
the preferred bed (Bed ID) to reserve the bed
for that patient.

Other information on theBedManagementWorklist
This topic describes some of the miscellaneous information that is displayed on the Bed
Management Worklist.

Bed placement actions that are performed for patients onBedManagementWorklist are displayed
as abbreviations in the Patient Tiles. The following abbreviations and their definitions are used:

> HOLD = Hold on Bed
> OPEN = Open Request Without Any Placement
> R2BD = Reserved to Bed
> R2UN = Reserved to Unit
> RBWC = Reserved to Bed, Waiting for Confirmation
> RUWA = Reserved to Unit, Waiting for Acknowledgment.
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Functions on the Bed Management Worklist

Use Filter options to display Units
Unlike the Filters function on the other Worklist pages, Bed Management Worklist Filters has
Display Results As. This filter can be used to filter the results shown on Bed Management
Worklist by either bed or by unit as shown in the following page.
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Figure 46: Bed Management Worklist Filters page

The Bed Management Worklist page displays the results if unit is selected as an option for the
Results filter. Available units are shown rather than available beds. (However, reserved beds are
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also shown as well as their units.) The units shown in the Assignment column are based on
Intelligent Matching Engine (IME) results. The following image is an example of a filtered Unit view.

Figure 47: Bed Management Worklist
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Figure 48: Unit View

The Bed Management Worklist page displays the results if unit is selected as an option for the
Results filter. Available units are shown rather than available beds. (However, reserved beds are
also shown as well as their units.) The units shown in the Assignment column are based on
Intelligent Matching Engine (IME) results.

Directly admitting a patient
You can directly admit a patient using Bed Management Worklist and Portal View by clicking

. The Direct Admit wizard is displayed.

Use IME matches to reserve or hold a bed
The Intelligent Matching Engine (IME) process automatically starts search and match terms to
score the beds independently and find available beds that match the patient's needs. The IME

June 23, 2022 | Allscripts Patient Flow 22.1 155
Bed Management User Guide
Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.

Functions on the Bed Management Worklist



process also calculates the percentage of needs matched by the bed and whether the bed meets
the match threshold.

The results of this process are displayed in the Assignment column for the patient's row of
information on Bed Management Worklist. When you click the patient's row, the row expands to
display several bed IDs that match the patient's needs. A percentage displays on the right of bed
ID to indicate the percentage of needs matched by the bed.

1. Scroll down or browse to another page ofBedManagementWorklist to find the specific patient
with a placement match.
The bed IDs for any bed matches display in the Assignment column in the specific patient's
row.

Figure 49: Bed Assignment Column

2. Click the patient's row of information to view any more bed matches.
3. Click a Bed ID for an available bed (indicated by a green icon) that has the highest match

percentage to open Bed Attributes.

Figure 50: Bed Attributes Window

4. Review the bed attributes and do one of the following:

a. To place a reservation on this bed, click .

The reservation icon is displayed next to the reserved Bed ID in theAssignment column,
and the other Bed ID matches are deleted from this column. The patient tile displays RBWC
(Reserved to Bed, Waiting for Confirmation), and a timer displays on the right to indicate
the time in this status.
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b. To place a hold on this bed, click . Clicking places a hold on the bed, and if
set up correctly sends a message to the requesting organization that follow-up is required
(such as approval of the reservation).

The hold icon is displayed next to the held Bed ID in the Assignment column, and the
other Bed ID matches are deleted from this column. The patient tile displays HOLD (Hold
on Bed), and a timer displays to indicate the time in this status. If you clicked a notification
message, the message is sent to the requesting organization for follow-up information. For
example, if the patient requested an A1 bed, but only a B1 bed is available, then this change
might require approval of the requesting organization.

Figure 51: Bed Attributes

c. To view more bed match results for this patient, click .
Bed ID closes and the first page of theBed Requestwizard for theBed Placement Request
is displayed. Bed Placement Request enables you to change needs and manually perform
a manual search.

d. To close the Bed ID without making a hold or reservation, click .

Cancel a bed reservation
To cancel a bed reservation on Bed Management Worklist, click on the right of the bed
reservation. (Do not click that displays following it, which cancels the bed request.)

Note: An open bed or unit reservation is automatically canceled when
the Care Level, Care Service or Attending Physician are updated. The
reservation icon is removed from the previously reserved bed tile in the
Unit View and the Pending Activity area of theBedManagementWorklist
and the bed is available for another patient. The user is able to reserve a
new bed for the patient after the previous reservation is canceled.
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Cancel a Bed Hold

There are 2 ways to cancel a bed hold on Bed Management Worklist. One way is to click on
the right of the bed hold. Another way is to click the bed ID for the bed hold in the Assignment
column. The following procedure uses the second method to cancel a bed hold on the Bed
Management Worklist.

1. Navigate the Bed Management Worklist to find the specific patient with the bed hold. Bed
holds are indicated by a Hold icon next to the bed ID in the Assignment column.

Figure 52: Bed Management Worklist

2. Click the Bed ID in the Assignment column.
The available options for the room display in a selection list.

Figure 53: Room Options

3. Select Cancel Hold.
The hold to the bed is canceled. The reservation information is removed from the Assignment
column and replaced with Find Bed.

4. The page might automatically refresh with more available beds. If it does not, click to
display more available beds.
The Intelligent Matching Engine process runs, and the bed ID matches for the patient display
in theAssignment column. If you prefer to search for a bed that the Intelligent Matching Engine
did not return, click Find Bed or More Suggestions in the Assignment column to search for
available beds.
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Reserve a bed manually
This procedure describes how to reserve a bed manually.

Usually, the Intelligent Matching Engine process automatically displays bed matches for a patient.
If no matches for a patient are found, Find Bed displays in theAssignment column for the patient.
Using a manual process, you can enter or change search criteria to find bed matches and reserve
a bed for the patient, as explained in the following procedure.

1. Find a patient with no bed placement matches on the Bed Management Worklist.

is displayed in the Assignment column for the specific patient's row.

Figure 54: Find Bed

2. In the Assignment column in the specific patient's row, click Find Bed.
Manual Search is displayed. Initially, No records to display. in the Results section.

Figure 55: Find Bed Results Window

3. There are several ways to change the request in order to display available beds for the patient.
Do 1 of the following to change the request:

> To edit the filters, go to Step 4.
> To edit the patient's needs, go to Step 6.
> To edit the patient's details, go to Step 10.

4. In the Filters section, enter changes in the applicable boxes, which are explained in the following
table. All boxes are optional. Removing options broadens the search results, displaying more
beds. Conversely, selecting more options narrows the search results, displaying fewer beds.
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PurposeData

Select the facility in which to search for a bed.Facility

Click a box to remove a check mark or to insert
a check mark in a blank box next to the
organizations in which to search for a bed.

Organizations

Click a box to remove a check mark or to insert
a check mark next to a care services used in
the bed search.

Care Service

Click a box to remove a check mark or to insert
a check mark next to care levels used in the
bed search.

Care Level

Enter the estimated from date and time for the
search. You can also click the calendar icon
to select the date and click the time icon to
select the time.

Est. Time From

Enter the estimated to date and time for the
search. You can also click the calendar icon
to select the date and click the time icon to
select the time.

Est. Time To

5. Do one of the following:

> To search for available beds, go to Step 13.
> To edit the patient's needs, go to Step 6.
> To edit the patient's details, go to Step 10.

6. Click .
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IME Needs displays a Needs section.

Figure 56: Needs Window

7. If a need is not specified, for example, Near Nursing Station, but it is required, click the
associated box to insert a check mark. Use the scroll bar to view other available options.
The check mark is inserted to include that specific requirement for the bed request.

8. Click .
IME Needs closes and the information is saved. Manual Search is displayed.

9. Do 1 of the following:

> To edit the patient's details, go to Step 10.
> To search for available beds, go to Step 13.

10. Click .
Patient Details is displayed.

Note: The boxes on Patient Details are configurable by your hospital
and might be different than the boxes shown in the following example.
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Note: The boxes on Patient Details are configurable by your hospital.

Figure 57: Attributes Tab

11. Enter the applicable changes on the Attribute tab of Patient Details, for example, selecting
the required Care Level and Care Service for the patient.

12. Click .
Patient Details closes and the information is saved. Manual Search is displayed.

13. Click to determine if there are available beds that meet the requirements of the
request.
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Manual Search displays available beds for the request.

Figure 58: Results Window

14. Navigate to the wanted bed in the Results section and click the adjacent box in the Select
column to insert a check mark.
A check mark displays next to the wanted bed indicating it is selected.

15. Click .
Manual Search closes and the bed reservation is completed. The patient tile for the patient
displays R2BD (Reserved to Bed) or RBWC (Reserved to Bed, Waiting for Confirmation).

Compare beds to make a selection
Use the compare function on Bed Management Worklist or Manual Search to determine which
bed is best suited to the patient. The Intelligent Matching Engine (IME) process automatically
displays bed matches, and the compare function enables you to view specific bed attributes,
compare them, and make the applicable bed selection. This procedure uses the compare function
on Manual Search.

1. Find the patient on Bed Management Worklist.

Figure 59: Patient Tile on Bed Management Worklist

2. Click More Suggestions. You can also click Find Bed if that option displays.

3. On Manual Search, select filters if needed, and then click , or click

to determine if there are available beds that meet the
requirements of the request.
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4. Select the beds you want to compare, and then click .

Figure 60: Manual bed search mixed comparison

5. On Mixed Comparison do one of the following:

> To remove a bed from the comparison, click .
> To reserve a bed, click .

> To hold a bed, click .

> To return to theBed Management Worklist, click .

Once you make a selection, Bed Management Worklist closes and you are returned to the
Worklist.
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6. To edit the patient's needs, click . Make the updates on IME Needs, and then click

.

Figure 61: IME Needs

7. To edit the patient's details, click . On Patient Details make the applicable

changes and then click .
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Note: The options on Patient Details are configurable by your hospital
and might be different than those shown in the following example.

Figure 62: Patient Details

Edit request details
To edit details of a request on Bed Management Worklist , click on the patient's row. The
name of the page that displays depends on the request, for example, Admission Request for a
Pending Admission. However, no matter which request you are editing, you are able to access
the Patient Details Screen and Patient Needs Screen to edit information.
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Note: If 2 users attempt to update patient details concurrently, a message
displays indicating the name of the user whose changes will be saved.
The other user should exit and try updating patient details again.

Reserve a unit or pod for a patient
When admitting a patient, you can reserve them to a unit or pod if there are no beds available.

Use Bed Management Filters to filter the results by Unit on Bed Management Worklist. When
results are filtered by unit, available units (for example, 1WA) are shown rather than available
beds. (However, reserved beds are also shown, in addition to their units.) The units in the
Assignment column are based on Intelligent Matching Engine (IME) results. If the results are
filtered by unit, use the following procedure to reserve a unit for a patient.

Note: Reserving a unit is actually reserving a pod of that unit.

When a unit or pod is reserved for a patient, no color is displayed around the Reservation icon

in theAssignment column. Colors differentiate a unit reservation from a bed reservation, which

shows the bed status color around the icon (for example, green for an open, available bed).

1. Find the patient on Bed Management Worklist.
The units matching the care service of the patient are displayed in the Assignment column on
the specific patient's row. For example, after the IME runs, a list of the beds or units matching
the care service is displayed and the percentage of match (based on 100%) is also displayed.

Figure 63: Unit Assignments
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2. To display more units in the Assignment column, click the patient's row.

Figure 64: Patient Tile

3. Take one of the following actions:

> To reserve a unit for the patient, click in the Assignment column.
Bed Management Worklist displays the patient's unit reservation. The patient tile displays
RUWA (Reserved to Unit, Waiting for Acknowledgment ). In the Assignment column,
because a unit or pod is reserved (not a bed), no color is displayed around the Reservation

icon .

Figure 65: Bed Management Worklist

> To find additional matching units for the patient, go to Step 4.
> To edit request details, click on the patient's row.

The name of the window that is displayed depends on the request (for example, Direct
Admit for a direct admit patient). However, no matter which request you edit, you can access
Patient Details and Patient Needs to edit information.

> To compare units, go to Step 9.

> To cancel the patient's Bed Request, click . Select a cancellation reason and click

.
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4. To find more matching units for the patient, click More Suggestions on the patient's row to
open manual search.

Figure 66: Manual Search

5. On Manual Search review the Filters and change them if needed, and then click .
Manual Search displays matching units and other information, including # Open Beds in each
unit. Clients using bed attributes (system option: MSBA = Y) will see the Bed Attributes column.

Figure 67: Unit Search

Note: Asia Pacific clients may see a Bed Class column.

6. In Results scroll down to the unit or bed and make selections.
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> If more than one unit is selected, the Compare button is displayed.
> If only one unit or bed is selected the following options are displayed:

— Reserve
— Hold

7. To compare units, click and then do one of the following:

> To reserve a unit for the patient, click .
Mixed Comparison closes and Bed Management Worklist displays the unit reservation
for the patient. The patient tile displays RUWA (Reserved to Unit, Waiting for

Acknowledgment). No color is displayed around the icon in the Assignment column
because a unit or pod is reserved, not a bed.

> To remove a unit from Mixed Comparison, click .

> To perform an automatic search, click .
IME Results displays any unit or bed that matches the search criteria. If there are no matches,
the statement No records to display is shown. Because this action is similar to
searching for beds, refer to Reserve a bed manually for more information about using this
window.

> To perform a manual search, click .
Manual Search is displayed (as shown previously), where you can perform a manual search

by selecting specific options in the Filters section and then clicking . For more
information about using this page, refer to Reserve a bed manually.

> To return to Bed Management Worklist, click Return to Worklist.
Manual Search closes and Bed Management Worklist is displayed.

Cancel a unit or pod reservation
An open bed or unit reservation is automatically canceled when the Care Level, Care Service or
Attending Physician are updated. When a unit reservation is canceled, the reservation icon is
removed from the previously reserved bed tile in the Unit View and the Pending Activity area of
the Bed Management Worklist, and the bed is available for another patient. The user is able to
reserve a new unit for the patient after the previous reservation is canceled.
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To manually cancel a unit or pod reservation on Bed Management Worklist, use the following
procedure.

Note: The Cancel button in the Assignment column on the
bottom right of the patient's row cannot be used to cancel a unit or pod
reservation. Clicking this button cancels the unit or pod reservation, not
the request.

1. Find the specific patient on Bed Management Worklist.

Bed Management Worklist displays the patient's unit or pod Reservation icon in the
Assignment column that has no color around it because a unit or pod is reserved, not a bed.

Figure 68: Bed Management Worklist

Figure 69: Cancel Reservation

2. Click the Cancel Reserve button on the far right of the Reservation icon in the
Assignment column.

The unit or pod reservation is canceled. The patient's unit or pod Reservation icon is
removed from the Assignment column. The units matching the patient's Care Service are
shown in the Assignment column.

Figure 70: Assignment Column

Direct reservations to units
The Bed Management module offers a feature that supports a unique placement process for areas
that manage their own beds. For example, units like Behavioral Health or Labor and Delivery might
receive admission requests directly and assign their own beds without involving Bed Management,
due to the specialized nature of their patients. Use of this feature requires configuration of a specific
Care Level which drives access to the "Unit Selection" arrow on Admission Request. By selecting
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the applicable unit, the bed request goes directly to that unit's 'pending incoming' list as soon as
the request is submitted. The system option DUBM can be applied at the unit or pod level so that
bed requests for that specific area do not show on the Bed Management Worklist, effectively
bypassing bed management altogether (if that is the process you want).

Export information to a report
To export information on Bed Management Worklist, click (Export) on the right of the page.
The Bed Management Worklist report displays, showing the information on Worklist in a report
format.

Figure 71: Bed Management Worklist Report
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Chapter 8

Bed Board

Bed Board enables you to view beds according to unit via tiles displayed in a grid format. You
can filter the resulting tiles according to various attributes, such as Bed Status. Clicking on the
unique Bed ID opens the Bed Details window. Additional links on the Bed Details window allow
access to Patient and Bed details. Bed Board has some of the same functions as Unit View.

Access the Bed Board
To access Bed Board, select Bed Management > Bed Board from the left navigation pane.

Figure 72: Bed Management Menu

To view a list of beds, you must first enter Filter Criteria at the top of the page and click Refresh
Now.
The Disable Auto Refresh box is selected by default to display a static view of the page. You can
select Refresh Now to manually refresh results, or enable Auto Refresh by clearing Disable Auto
Refresh, and at periodic intervals the results will automatically refresh.
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Bed Board functions are described in the following sections.

Figure 73: Bed Board

Use the Filter Criteria pane
The Filter Criteria pane at the top ofBed Board enables you to filter the display of beds according
to various attributes.

Figure 74: Bed Board Filter Criteria

When Bed Board initially displays, no beds are shown, even though the filters may be set at the
Show All selection. Update the filter settings in Filter Criteria as required and select Refresh
Now to see the resulting beds.
To change Show All and specify filter criteria, click the selection arrow next to the applicable
boxes, and select 1 or more options by clicking the correct boxes. You can select 1 or multiple
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options for each box. If you do not want to use a specific option to filter data, leave the default
Show All option.

Figure 75: Organization Filter Criteria

Use the Organization filter to select specific organizations (for example, units) limiting search
results, in order to display the search results in a timely manner. Bed Board is not limited in the
number of beds it can display, but the greater the number of organizations, the more beds displayed,
and the more time it takes for beds to display on the page.
When choosing multiple organizations, a warning message indicating that results may take longer
than usual to display appears. A configurable system option, named Bed Board - Max Number of
associated organizations before pre-filtering, determines the maximum number of organizations
that triggers this message to display.

Figure 76: Multiple Organizations Warning

After selecting the required options, click on the lower right side of the Filter Criteria
pane. If no beds match the search criteria, no records are displayed below the Filter Criteria pane.
If you do not want to view the Filter Criteria pane, you can collapse it by clicking the Collapse

All button . To view the Filter Criteria pane again, click the Expand All button .

Note: When the Filter Criteria pane is collapsed, the Bed Board refreshes
and that space displays the Bed Board.
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View details of beds, patients, and pending
requests
On Bed Board, clicking the unique Bed ID on a tile opens Bed Details.
An unoccupied bed displays the Bed Turnover, Bed Closure, Attributes, and Requests tabs.

Figure 77: Unoccupied Bed: Bed Details Window

If a patient is occupying the bed, clicking the unique Bed ID opens Bed Details with Patient
Information, Bed Turnover, Bed Closure, Attributes, and Requests tabs. To view patient
details, click the Patient Details link on the Bed Details window.
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Note: To open Patient Details from the Bed Board tile, you must have
the Bed Board – Patient Summary PopUp authorization item enabled
for the user's role.

Figure 78: Occupied Bed: Bed Details Window

Based on your organization's security policy, you might or might not have the ability to see Patient
Details on Bed Board. Contact your System Administrator to set up the following Auth Items
called Bed Details – Patient Details and Bed Details – Patients Tab. (See Administrator Tools
User Guide, Chapter 4, User Maintenance, Create authorization roles).
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If you hover over the bed tile icon and have been granted the appropriate authorization (Bed Board
Patient Summary pop–up associated to user role) item by your System Administrator, you will see
a condensed window with patient information.

Figure 79: Patient Information shown at Bed Tile Hover

Clicking an icon, such as Transfer, Transport or Discharge, in a bed tile opens a window with
details on that icon; for example, Pending Transfer. The actions available for that icon display at
the bottom of the pop–up. While most actions would take place from the Unit View, if your user
role has the appropriate permissions associated, some actions may be completed from the bed
tile.

Figure 80: Pending Transfer Window
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Chapter 9

Admissions Worklist

The patient activities that display on Admissions Worklist are dependent on your system
configuration. The page can be configured to display only Direct Admits, or it can be configured
to display other patient changes, such as Patient Admits, Departs, and Data Updates.
Direct Admit on the Portal View andBedManagementWorklist enables you to enter information
for a Direct Admit patient in Allscripts Patient Flow™. The Direct Admit activity displays on these
pages and on Admissions Worklist. The patient's information might also have been entered into
the hospital's system (for example, ADT) using a separate data entry or HL7 process. In this
scenario, there are 2 admission records for the same patient, 1 in Allscripts Patient Flow™ and 1
in the hospital system.
If details are missing from the patient's record in the hospital's system, you can view the patient's
details onAdmissionsWorklist and enter them in the hospital's system. TheAdmissionsWorklist
also has a Match and Merge function for Direct Admit patients. This function synchronizes a
patient's information in the hospital system with the patient's information in Allscripts Patient Flow™.
The 2 records are consolidated, creating 1record with all information collected for the patient.
However, perform the Match and Merge function carefully because there is no undo process.

Accessing the admissions worklist
To access Admissions Worklist, click Bed Management > Admissions Worklist.

Figure 81: Bed Management Menu

Admissions Worklist is displayed.
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To view more patient information, click the patient's row. More information about the patient is
displayed in the right window. This information varies, according to patient activity. For example,
the boxes for a Pending Discharge differ from the boxes for a Patient Move.

Figure 82: Admissions Worklist

Admissions Worklist functions

View the patient change transaction types
Patient change records created by workflows are displayed onAdmissionsWorklist. The following
table describes the 8 patient change transaction types in Allscripts Patient Flow™ that can display
on Admissions Worklist.

Intended UseGenerated ByTransaction Type

Provide info for registering the
patient in the ADT system.

Adding a Direct AdmitDirect Admit

Merge PF and ADT patient
accounts into 1 record.

Completing a Direct AdmitDirect Admit Match
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Intended UseGenerated ByTransaction Type

Provide information for
Admitting staff to convert the
patient account.

Requesting an AdmissionPatient Admit *

Notify Admitting staff the patient
has physically arrived in the
reserved location.

Arriving a patientPatient Arrival

Notify Admitting staff to update
patient information in the ADT
system.

Changing a value of certain
Patient Details boxes

Patient Data Update *

Notify Admitting staff the patient
has physically left his or her
current assigned location.

Departing a patientPatient Depart *

Notify Admitting staff the patient
has physically departed his or
her current assigned location
for a discharge.

Discharging a patientPatient Discharge Depart *

Notify Admitting staff the patient
now has an expected discharge
date.

Entering a pending DischargePending Discharge *

*A System Option (SPCH) can be used to turn off the display of these patient change workflows.

Use the buttons on the Admissions Worklist
Two buttons display at the bottom right of Admissions Worklist (scroll down the page to view
these buttons). These buttons enable you to perform several functions on this page. Patient Details
displays on the right pane whenever a patient's row is selected. Clicking this button displays Patient
Details, which enables you to view more information for the patient selected.
For some patient activities, Complete also displays. When you have finished using the patient's
activity information on Admissions Worklist to enter details for the patient in the hospital's ADT
system, you do not have to have the patient's activity record on Admissions Worklist. Clicking
Complete removes the patient's activity record fromAdmissionsWorklist. This does not remove
the patient's information from Allscripts Patient Flow™, just the patient's activity record from
Admissions Worklist .
If a Direct Admit request is waiting for an ADT registration in Allscripts Patient Flow™, then Direct
Admit Match displays in the Type column. Clicking the patient row with this type displays Direct

June 23, 2022 | Allscripts Patient Flow 22.1 181
Bed Management User Guide
Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.

Admissions Worklist functions



Admit Match in the right pane. Scrolling down the right pane displays a Match button at the bottom
of the right pane. Two Direct Admit Match System Options drive the selection of patients to display
as possible matches. The DMMC System Option is the minimum number of characters of the last
name to match (typically 3 characters). The DMMH System Option is the maximum number of
hours (typically 24 hours) to look back for a patient visit that was created from an external source.
The patient must meet both criteria to display as a possible match.

If you click the matching patient's row in the right pane and click , the patient's records are
merged. The information for the matching patient in the table overwrites the information in the top
part of the pane. When the page refreshes, the matching patient's row no longer displays in the
right pane on AdmissionsWorklist. Because the Match function is available only for Direct Admit

Match patients, the button displays only for this type of patient activity.

Use Patient Details to update the hospital patient record
This topic describes how to update a patient's record.

If you have the authorization item, Patient Details–Update assigned to your user name or your
user role, you can view the patient's details on Patient Details and enter any missing details in
the patient's record in the hospital's system.

1. Click the specific patient's row on the Patients List.
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Some information for the patient is displayed on the right pane.

Figure 83: Patient List

2. To view more details for the patient, click .
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Patients Details displays the Attribute tab.

Figure 84: Patient Details

3. On the Attribute tab of Patients Details, enter any missing details from the patient's record
on the hospital system's window.
You can view patient details on the Attribute, Requests, Notes, Contacts, Medical Provider,
Task List, andCV Indicators tabs or perform other actions on this window. For more information
about Patient Details, refer to Use the patient details panel for more information.

4. Click each tab and enter any missing details in the hospital system's patient record.

5. Click to return to Admissions Worklist.
Admissions Worklist is displayed.

Note: If two users attempt to update a patient's details concurrently,
a warning is displayed to the secondary user indicating that the primary
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user's changes will be saved and that the secondary user must exit
and re-enter any changes.

Use the Direct Admit Match/Merge function
If there are two records for the same Direct Admit patient, you can use the Match/Merge function
to match the patient records and merge them into one record.

Ensure that the patients match and are the same prior to merging the patient records.

Note: Because there is no undo process for this function, ensure that the
two patients are the same person prior to matching and merging the
records.

1. Click the specific patient's row of information with a Direct Admit on the Patients List.
Direct Admit Match displays at the top of the right pane, and more information for the patient
displays following the title.

Figure 85: Admissions Worklist: Direct Admit Match

2. Do one of the following:

> If the name of a matching patient displays in the Patient column, go to Step 8.

June 23, 2022 | Allscripts Patient Flow 22.1 185
Bed Management User Guide
Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.

Admissions Worklist functions



> If the name of a matching patient does not display in the Patient column, go to Step 3.

3. Click near the bottom of the right pane.
Patient Locator displays with the patient's last name displayed by default in the Last Name
box.

Figure 86: Patient Locator

Optionally, enter any other information in the SEARCH section to narrow the search, such as
the patient's first name.

4. Click .
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Patient Locator displays any patients that match the search criteria.

Figure 87: Patient Locator

5. Click the row with the matching patient information.
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The Patient Information and Patient Location sections display information for the selected
patient.

Figure 88: Patient Locator

6. Compare the information for the two patients.
For example, if the MRNs are the same, then the two patient records are for the same person.

7. Do 1 of the following:

> If the patient is a match, click .
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Patient Locator closes and Admissions Worklist is displayed.

Figure 89: Admissions Worklist: Direct Admit Match

> If the patient is not a match, click .
Patient Locator closes and Admissions Worklist is displayed. No patient displays as a
match on the right pane.

8. If the two patient records are for the same person, click near the bottom of the right pane.
The two patient records are matched and merged into one record. The patient's Direct Admit
Match record is removed from Admissions Worklist in Allscripts Patient Flow™.
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Chapter 10

Closed Bed Worklist

Closed Bed Worklist displays beds closed for several reasons, such as a repair or renovation.
This page enables you to view bed closure details, update or cancel the bed closure, or reopen
the bed. A timer displays in the Patient Tile to indicate how long the bed was in the Closed status.
The beds are displayed in descending order by time in the Closed status, with the oldest bed
closures displayed at the top of the page.

Closed Bed Worklist Functions
The Start and End date and time information on Closed Bed Worklist represents time estimates
for the bed closure. If you schedule the bed closure for the future, the bed automatically becomes
closed when the bed is empty, clean, and the Start date and time has passed. Your system
configuration determines whether a closed bed stays on Closed Bed Worklist after reaching the
End date and time. If automatic reopening is not set, then you must reopen the bed manually in
order to remove the bed from Closed Bed Worklist. The End time box is not a required value to
submit the form.
Edit, Open, and Cancel display in the Action column on Closed Bed Worklist. For unoccupied
beds, a black patient tile indicates a current bed closure, and a green patient tile designates a
future bed closure. A blue or pink patient tile indicates a patient still occupies the bed. Any other
color in the patient tile indicates a bed-cleaning request.

Edit bed closure information
You can edit information for a bed closure by following the procedure. (Bed closure edits can also
be performed on Unit View and Bed Board by clicking the Bed ID, which displays Bed Details
where you can enter information.) Close Reason and Start Date on Bed Status can only be
updated if the bed closure is scheduled for a future date and time. The following procedure uses
the example of a future–dated bed closure.

1. Find the row with the specific bed closure that needs to be edited.
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The row with the specific bed displays.

Figure 90: Row with Specific Bed

2. Click .
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Bed Details is displayed.

Figure 91: Bed Details
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Figure 92: Bed Details

3. Do 1 of the following:

> To change the close reason for a future close, click the Reason selection arrow and
select a reason.
The reason displays in the Reason box.

> To change the begin date and time for a future close, type the changes in Timeframe Start
or click or icons and select the new date or time.
The changed date or time displays in Timeframe Start.

> To change the end date or time, type the changes in Timeframe End or click or icons
and select the new date or time.
The changed date or time displays in Timeframe End.
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Note: Timeframe End is not required to submit the form.

To cancel the bed closure, go to Step 5.

4. Click .

Note: Clicking does not save the changes made in the Bed
Status section.

The bed closure's information is updated and Bed Details closes. The updated bed closure
information is displayed on Closed Bed Worklist.

5. To cancel the bed closure, click the Cancel Reason selection arrow and select a reason.
The reason displays in Cancel Reason.

6. Click .
The bed closure is canceled, and the bed is removed from Closed Bed Worklist.

Open a closed bed
To open a closed bed closure on Closed Bed Worklist, follow the procedure below.

1. Find the row with the specific bed that needs to be reopened.
The row with the specific bed displays.

Figure 93: Closed Bed Worklist

2. Click .
The bed is opened and removed from Closed Bed Worklist.
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Cancel a bed closure
To cancel a bed closure on Closed Bed Worklist, follow the procedure below.

1. Find the row with the specific bed that needs to be canceled. Scroll down or browse to another
page, as necessary.
The row with the specific bed displays.

Figure 94: Closed Bed Worklist

2. Click .
Cancel is displayed to request a reason for the cancellation.

Figure 95: Cancel Window

3. Select a Reason for the cancellation.
The reason displays in the Reason box.

4. Click on Cancel.
The bed closure is canceled, and the bed is removed from Closed Bed Worklist.
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Change the bed-cleaning information on a closed bed
You can change bed-cleaning information on a closed bed using the Closed Bed Worklist.

1. Find the row with the specific bed that needs to be reopened.

Figure 96: Closed Bed Worklist

2. Click .
Bed Details is displayed. Select Bed Turnover to schedule the cleaning.

3. Select a cleaning type from Clean Type.
4. Select a cleaning priority fromClean Priority. Ensure you have clean priority permissions before

selecting Clean Priority.

5. Click to save the information.
The information is saved, and Bed Details closes. The color of the patient tile on Closed Bed
Worklist changes to brown to indicate the dirty bed status.

Figure 97: Bed Details
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Chapter 11

Facility-to-facility transfers

Facility-to-facility-transfer requests
Use facility-to-facility transfer requests to carry out admission requests, manual or ADT transfer
requests, and area transfer requests.

When you use facility-to-facility transfer requests for admission requests, manual or ADT transfer
requests, and area transfer requests, the patient record is displayed with the transfer information
in red text. The red text indicator shows the facility that the patient is transferring from and the
facility the patient is transferring to.

Figure 98: Example patient record with AD icon and transfer location information

Note: The indicator follows the bed tile on theBedManagementWorklist
(BMWL) of the sending facility.
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Chapter 12

Bed Hold

Administrative settings for Bed Hold
The settings on this page are for configuring administrative settings for Bed Hold.

Before using the Bed Hold, these administrative settings must be configured inAdmin > Advanced
Maint and Admin > Facility Maint.

1. Go to Admin > Advanced Maint > System Options, ensure that THLD is set to Y.
2. In Admin > Advanced Maint > Location Status Reasons, ensure that HOLD is available.
3. In Admin > Facility Maint > Organization > Facilities > Location Status Reason, select

Hold bed for patient's return.
4. In Admin > Facility Maint > Organization, select either Units or Pods and then select

Procedural Unit.
5. In Admin > Facility Maint > Location > Beds, select the bed location that you want to use for

the facility-to-facility transfer.
The beds are associated with the pods or units that are your procedural beds.

Important: In the top part of the location record, do not selectGenerate
Clean Request.

Transfer a patient to a procedural unit
Use HOLD to transfer a patient to a procedural unit.

When a patient is transferred to a procedural unit, the bed is displayed with a HOLD status.

Figure 99: Patient Bed On Hold

This status indicates that the bed is closed and cannot be used by another patient. You cannot
create a BTO job.
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If a patient is transferred to a different bed after the procedure, you must open the bed manually.
As a result, a BTO job is created and the bed becomes available for a new patient.
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For more information

For more information and the most up-to-date documentation, go to the Allscripts Central website
at https://central.allscripts.com. You can access the Product Documentation portal from this
website.

1. Sign in to the Allscripts Central website.

> If you have an Allscripts Central account, enter your user name and password, and click
Sign in.

> If you do not have an Allscripts Central account, click Create one to begin creating a new
account.

The Allscripts Central home page is displayed.

2. Go to My Products > Product Documentation.
The Product Documentation portal landing page is displayed.
The list of products under the Product Name box reflects your preferences in Allscripts Central
Central. You can navigate to the documentation for a product usingProduct Name in conjunction
with the search function.
Product tiles are also displayed and reflect your Allscripts Central preferences.

3. From Product Name, select the product on which to search for documentation.
Product Name uses predictive searching, so as you type the product name, the list displays
only matching products. Select the correct product when it is displayed.

4. In the search box, enter search criteria.
The search box also uses predictive searching. As you type, topics that match the criteria are
displayed below the search box.

5. To complete your search, perform one of the following actions:

> Click the magnifying glass.
> Select one of the topics displayed beneath the search box.

Search results are displayed in the main pane. You can use the filters in the left pane to further
narrow your results. For example, you can select Feature Guides from Document Type to
display only topics that are included in a feature guide.

6. Click a topic title to open the topic in the context of the book indicated by the product, version,
and document type tags that are displayed beneath the title.

June 23, 2022 | Allscripts Patient Flow 22.1 203
Bed Management User Guide
Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.

https://central.allscripts.com


Note: If a topic is included in more than one book, a list of the books
in which the topic is included is displayed beneath the topic title. Select
the applicable book from the list. The topic opens in the context of that
specific publication.

What to do next
You can navigate the Product Documentation portal using multiple methods. From the bottom of
the portal landing page, click Helpful Tips under Getting Started to learn more about using the
portal.
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